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The information provided in this documentation contains general descriptions and/or technical 
characteristics of the performance of the products contained herein. This documentation is not 
intended as a substitute for and is not to be used for determining suitability or reliability of these 
products for specific user applications. It is the duty of any such user or integrator to perform the 
appropriate and complete risk analysis, evaluation and testing of the products with respect to the 
relevant specific application or use thereof. Neither Schneider Electric nor any of its affiliates or 
subsidiaries shall be responsible or liable for misuse of the information contained herein. If you 
have any suggestions for improvements or amendments or have found errors in this publication, 
please notify us. 
You agree not to reproduce, other than for your own personal, noncommercial use, all or part of 
this document on any medium whatsoever without permission of Schneider Electric, given in 
writing. You also agree not to establish any hypertext links to this document or its content. 
Schneider Electric does not grant any right or license for the personal and noncommercial use of 
the document or its content, except for a non-exclusive license to consult it on an "as is" basis, at 
your own risk. All other rights are reserved.
All pertinent state, regional, and local safety regulations must be observed when installing and 
using this product. For reasons of safety and to help ensure compliance with documented system 
data, only the manufacturer should perform repairs to components.
When devices are used for applications with technical safety requirements, the relevant 
instructions must be followed. 
Failure to use Schneider Electric software or approved software with our hardware products may 
result in injury, harm, or improper operating results.
Failure to observe this information can result in injury or equipment damage.

Silverlight® is a registered trademark of the Microsoft Corporation.

Expression Blend® is a registered trademark of the Microsoft Corporation.
© 2017 Schneider Electric. All Rights Reserved.
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Safety Information
Important Information

NOTICE
Read these instructions carefully, and look at the equipment to become familiar with the device 
before trying to install, operate, service, or maintain it. The following special messages may appear 
throughout this documentation or on the equipment to warn of potential hazards or to call attention 
to information that clarifies or simplifies a procedure.
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PLEASE NOTE
Electrical equipment should be installed, operated, serviced, and maintained only by qualified 
personnel. No responsibility is assumed by Schneider Electric for any consequences arising out of 
the use of this material.
A qualified person is one who has skills and knowledge related to the construction and operation 
of electrical equipment and its installation, and has received safety training to recognize and avoid 
the hazards involved.
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About the Book
At a Glance

Document Scope
This manual presents the Web Designer for Modicon M340, Modicon M580, Premium, and 
Quantum software and describes the installation and operation.
NOTE: In this manual, the term Web Designer refers to Web Designer for Modicon M340, M580, 
Premium, or Quantum.

Validity Note
This documentation is valid for Web Designer software.

Related Documents

You can download these technical publications and other technical information from our website 
at http://www.schneider-electric.com/en/download

Title of Documentation Reference Number

Objects Library for Microsoft Expression Blend® S1A75812
FactoryCast for Modicon M340 User Manual 35015192 (English), 35015193 

(French), 35015194 (German), 
35015195 (Spanish), 35015196 
(Itlian), 35015197 (Chinese)

FactoryCast for Premium and Quantum User Manual 31001229

Modicon M580 BMENOC0301/11 Ethernet Communications Module 
Installation and Configuration Guide

HRB62665 (English), HRB65311 
(French), HRB65313 (German), 
HRB65314 (Italian), HRB65315 
(Spanish), HRB65316 (Chinese)

Modicon M580 BMENOC0321 Control Network Module Installation 
and Configuration Guide

NVE24232 (English), NVE24233 
(French), NVE24237 (German), 
NVE24240 (Italian), NVE24239 
(Spanish), NVE24242 (Chinese)

Communications Setup Manual TLX DS COMPL7 V4
Ethernet Network - Reference Manual TSX DR ETH

Modbus - User Guide TSX DG MDB
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Product Related Information
All pertinent state, regional, and local regulations must be observed when installing and using this 
product. Only the manufacturer should perform repairs to this product to maintain system data.
When controllers are used for applications with technical requirements, please follow the relevant 
instructions. 

Anyone who has access to a configuration tool and to your embedded server can override your 
security settings and download new settings to the server.
Unauthorized or incorrect changes to data may change the behavior of your application in ways 
that may be undesirable or even hazardous.

WARNING
UNINTENDED EQUIPMENT OPERATION
Use only Schneider Electric software or approved software with our hardware products.
Failure to follow these instructions can result in death, serious injury, or equipment damage.

WARNING
UNINTENDED EQUIPMENT OPERATION
 

Keep strict access to the embedded server by configuring passwords.
Carefully select the symbols and direct addresses you authorize to be modified online.
Do not authorize online modifications of critical process variables.

Failure to follow these instructions can result in death, serious injury, or equipment damage.
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Chapter 1
Introducing Web Designer

Overview
This chapter is an introduction to Web Designer. It contains installation instructions and a 
description of the graphical interface.

What Is in This Chapter?
This chapter contains the following topics:

Topic Page

About Web Designer 10
Web Designer Installation 12

The Web Designer Interface 13
35016149 10/2017 9



Introducing Web Designer
About Web Designer

Introduction 
Web Designer is a software application that you can use to create Web-based operator panels and 
configure operating parameters for Web human machine interface (Web HMI) devices. 
Web Designer contains the tools for designing an HMI project from data acquisition to the creation 
and display of Web animation.
Use Web Designer for these tasks:

editing Web sites
configuring Web Sites
modifying Web Sites

Web Designer offers two levels of personalization:
You can create a variable base of devices that are viewed and modified in Web pages. 
You can add your own Web pages on the device site.

Devices
In the Schneider product range, Web Designer unites website configuration with services carried 
out in the coupling unit or device. A project can simultaneously manage several devices.
Web Designer manages these devices:

Simulation
Web Designer enables you to simulate devices to debug the application. This means you can verify 
the behavior of Web pages and services without a physical connection to the device or module.

PLC Range Device

Modicon M340 BMX NOE 0110 and BMXNOR0200
Modicon M580 BMENOC0311 and BMENOC0321

Premium TSX ETY 5103

Quantum 140 NOE 771 11
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Introducing Web Designer
PC Requirements
To optimize your experience with Web Designer, we recommend that your PC meets these 
requirements:

Opening Applications from Interim Target-Patched Versions of Web Designer
Some versions of Web Designer, earlier than version 3.0, were patched with a file to target an 
interim exec firmware version such as BMX NOE 0110 version 4.51. Applications created with 
such versions of Web Designer might not open as expected in the latest version of Web Designer.
If your application was created with a version of Web Designer earlier than version 3.0 that was 
patched for an interim firmware version, and does not open as expected in a later Web Designer 
version, perform the following steps. 

PC Component Operating System
Windows 10 Pro (64-bit) Windows 7 Pro (64-bit) Windows XP Pro (SP3)

System Pentium processor 
2.4 GHz or higher 
(3.0 GHz recommended)

Pentium processor 
2.4 GHz or higher 
(3.0 GHz recommended)

Pentium processor 
1.2 GHz or higher 
(3.0 GHz recommended)

RAM 2 GB minimum 
(4 GB recommended)

2 GB minimum 
(3 GB recommended)

1 GB minimum 
(2 GB recommended)

Hard disk 
(available free space

8 GB minimum 8 GB minimum 8 GB minimum 

Internet browser IE 11.0 or later IE 7.0 or later IE 7.0 or later
Java Virtual Machine Version 1.8.0 or later Version 1.4.2 or later Version 1.4.2 or later
Silverlight plug-in Version 5.0 or later Version 4.0 or later Version 4.0 or later

Step Action
1 Open the folder containing the project. For instance:.

C:\Documents and Settings\user name\My Documents\Schneider Electric\Web 
Designer\projects\project name
where user name is your Windows login name and project name is the name of the project 
you want to edit.

2 Use a text editor such as Wordpad to open the file TargetVersion.xml. Locate the lines that show 
the target firmware version. For instance, in the following example, the target firmware version is 
4.51, as indicated by the values of target firmwareVersion and version:
<?xml version="1.0" encoding="UTF-8" ?>- <Targets>      <target firm-
wareVersion="v4.51" name="TSX ETG 3021-Target0" version="4.51" /></Tar-
gets>

3 Change the values of target firmwareVersion and version to reflect the latest Web 
Designer version number. For instance, in the following example, the latest Web Designer 
version is 5.0.
<?xml version="1.0" encoding="UTF-8" ?>- <Targets>      <target firm-
wareVersion="v5.0" name="TSX ETG 3021-Target0" version="5.0" /></Tar-
gets>

4 Save the TargetVersion.xml file.
35016149 10/2017 11



Introducing Web Designer
Web Designer Installation

Installation
Install Web Designer from the CD:

After the Installation
After Web Designer is installed, you can open it (Start → All Programs → Schneider Electric → 
SoCollaborative → Web Designer → Web Designer).
Your existing projects appear in the navigator when Web Designer is reinstalled.

Step Action

1 Insert the CD into your computer.
2 Open the Web Designer CD in Windows Explorer.

3 Open the WebDesigner folder; then double-click the setup file (setup.exe).

4 Follow the on-screen instructions.
12 35016149 10/2017



Introducing Web Designer
The Web Designer Interface

Main Window
This is the main window of the Web Designer:

Legend:

1 The menus (see page 148) contain commands for various functions. 

2 The toolbar contains shortcuts to frequently used functions. (Hover the cursor over each button in the 
toolbar to display its function name.)

3 The Navigator pane (see page 14) displays files related to your project.
4 You can edit, create, and configure services associated with your project in these columns.

5 The Console contains a list of recently detected errors. 
6 This area contains information like the connection status and available memory for the selected module.
35016149 10/2017 13



Introducing Web Designer
Navigator
The Navigator zone displays the files and folders associated with existing projects. It provides an 
overall view of the application in a file tree:

New Project: This is the name of the project as root directory. Click the plus sign (+) to make the 
targets associated with the project appear.
BMX NOE 011-Target0[10.10...: This folder displays the name of the target associated with the 
project and its IP address. Click the plus sign (+) to make the folders and files associated with the 
target appear.
The main directories are visible for each target associated with the project:

Device: This directory displays the devices (CPUs connected to the module) associated with the 
target.
GraphicScreens: This directory contains these items:

HTML pages (from the Graphic editor (see page 82))
Silverlight pages (from Microsoft Expression Blend® (see page 120))

DataTables: This directory contains tables created in the Data editor (see page 72).
Website: contains the website files for the project. You can customize the website by changing 
these files or by adding your own pages.
14 35016149 10/2017



Introducing Web Designer
Toolbar
The toolbar gives you quick access to the main Web Designer functions through clickable icons:

You can scroll over each icon to see its name. This table contains a description of the functions:

Icon Name Description

1 New Scroll through the menu to create a new item:
Project
Target
Device
Service
Folder
File

2 Open Project Open an existing project.

3 Save Save the currently edited window.
4 Save All Save multiple items modified in the project.

5 Cut Cut the selected object to the clipboard.
6 Copy Copy the selected object to the clipboard.

7 Paste Paste the content of the clipboard.

8 Undo Cancel the last performed action.
9 Find Open the Search window to find text in a project file.

10 Lookup Open the Lookup window to search for available variables.

11 Global Transfer Download the project's modules (and associated files).
12 Target->PC Transfer a project from the target to the PC.

13 PC->Target Transfer a project from the PC to the target.

14 Connection to the module Connect Web Designer to the target.
15 Connect to local simulator Connect Web Designer to the simulator.

16 Disconnect Disconnect Web Designer from the target or simulator.
17 Statistics View statistics for the selected service (incoming messages, 

outgoing messages, etc.).
18 Stop Terminate the current service.

19 Run Start the current service.

20 Operator Screens View the operator screens.
21 PLC Program Viewer View the PLC Program Viewer.
35016149 10/2017 15
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Chapter 2
Getting Started

Create a Web Designer Application
Use the procedures in this chapter to create a Web Designer application.

What Is in This Chapter?
This chapter contains the following topics:

Topic Page
Overview of the Web Designer Application 18

Creating a New Project 19
Selecting Devices 20

Target Properties 22

Variable Selection 24
Data Editor 26

Graphic Editor 28

Transfer 30
Accessing the Website 32
35016149 10/2017 17



Getting Started
Overview of the Web Designer Application

Introduction
In this book, you will create an example architecture in a Web Designer project that can be viewed 
in your PC’s browser. The example uses a BMX NOE 0110 module and a Modicon M340 PLC on 
the same rack. 
The Web server is hosted by the BMX NOE 0110 module, which periodically scans the values of 
variables located in the PLC. The IP address that is implemented for the module is a.b.c.d. 

Architecture
This figure shows the architecture of the example:

This table shows the components used in the example:

Reference Type Description
BMX NOE 0110 Target Ethernet module

Modicon M340 Device PLC
18 35016149 10/2017



Getting Started
Creating a New Project

New Project Window
Create a project that uses a BMX NOE 0110 module with the Project Creation Wizard window in 
Web Designer (Project → New → Project):

NOTE: The preceding graphic depicts a Web Designer version earlier than version 3.0. In Web 
Designer version 3.0, the Target List does not display the version number. As a result, only a single 
target is displayed in version 3.0.

Creating a Project
In the Step 1 screen for the Project Creation Wizard (above), assign a name in the Project field (for 
example, Modicon_M340_example).
In the Target List, expand FactoryCast.
Add target devices to the project:

Click the Next button to go to the Step 2 screen for the Project Creation Wizard.

Step Action
1 Select a module from the Target List (for example, BMX NOE 0110 v5.0).
2 Click the move button (>). (The selected module appears in the first row of the Selected Target(s) 

column.)
3 In the Name column, you can replace the default target name (Target0) with a more appropriate 

name.
4 In the Address column, enter the IP Address (a.b.c.d) of the target. (For more information about 

IP addressing, refer to the Modicon M340 for Ethernet Communications Modules and Processors 
User Manual.)

5 Repeat these steps to select additional targets.
35016149 10/2017 19



Getting Started
Selecting Devices

Introduction
Continue using Web Designer to select devices and variables.

Step 2 Screen
For each target in the new Web Designer project, you can configure the devices that are connected 
to it on the Step 2 screen for the Web Designer:

NOTE: The preceding graphic depicts a Web Designer version earlier than version 3.0. In Web 
Designer version 3.0, the Target List does not display the version number. 
20 35016149 10/2017



Getting Started
Selections
This table describes the fields in the above screen:

Click Finish to make the example appear in the Navigator pane in the Web Designer.
Save your project.

Device List Select a device in the Device List and click the move (>) button to make the device 
appear in the Target/Device column. Do this for every device you want to add to 
the target.

Selected 
Target(s)/Device(s)*

Name: Enter the name of the device.

Address: Enter the address of the device.
Protocol: Enter the desired protocol (if the device supports several protocols).

*For more information about addressing refer to the Modicon M340 for Ethernet Communications Modules 
and Processors User Manual.
35016149 10/2017 21



Getting Started
Target Properties

Introduction
You can change the name and address of a target in the Properties window in Web Designer. In 
this example, you can manually configure IP parameters for a BMX NOE 0110 module.

Accessing the Target Properties Page
Access the Target Properties page with one of these steps:

In the Navigator pane in the Web Designer, expand the project name, right-click the target, and 
scroll to Properties.
On the Target menu, click Properties.

The Properties window appears:
22 35016149 10/2017



Getting Started
Setting Up the IP Parameters
For this example, enter a.b.c.d in the Address field to assign that IP address the BMX NOE 0110 
module.
NOTE: For details about managing IP addresses, refer to the Modicon M340 for Ethernet 
Communications Modules and Processors User Manual.
Having two devices with the same IP address can cause unpredictable operation of your network.

NOTE: In this example, we manually assign the address a.b.c.d to the BMX NOE 0110 module. 
For details about managing IP addresses, refer to the Modicon M340 for Ethernet Communications 
Modules and Processors User Manual.

Applying Target Properties
After you enter an IP address for the BMX NOE 0110 module, click OK to apply the changes and 
save your project.

WARNING
UNINTENDED OPERATION — DUPLICATE IP ADDRESS

Assign the device a unique IP address.
Obtain the IP address from your system administrator to avoid the possibility of duplicate IP 
addresses.

Failure to follow these instructions can result in death, serious injury, or equipment damage.
35016149 10/2017 23



Getting Started
Variable Selection

Introduction
Device variables within a project are grouped in a file called Namespace. The data editor and 
graphic editor in a project use the variables in the Namespace.

Symbol Types
For M340, M580, Premium, and Quantum PLCs, use symbols from the PLC application (.stu or 
.xvm file type). 

Selecting PLC Symbols
View the list of devices:

View the list of devices:

Step Action
1 Select a project in the Navigator pane in Web Designer.

2 Click the plus sign (+) to expand the target directory.

3 Double-click the Devices directory.
4 Double-click a device in the Devices directory.
24 35016149 10/2017



Getting Started
Use these steps to select PLC symbols:

Viewing Groups of Targets and Devices
Click Namespace in the Navigator pane to view a table that groups the symbols you previously 
selected for targets or devices.

Variable Refresh
When using the Project Creation wizard, the list of variables may take a while to refresh.
NOTE: The PLC Program Viewer does not work with the Data dictionary turned off. If you need to 
use the PLC Program Viewer, limit the use of the Dynamic Namespace feature in FactoryCast 
devices. Variables that do not exist in Unity Pro will not work correctly on Data Editor and Graphic 
Editor web pages.

Step Action
1 In the device window, click Import PLC symbols to view the Open window.

2 Select the (.stu or .xvm) file that contains the application symbols.

3 Click Open to view the Selection of the variables to import dialog box:

4 Double-click a row in the first table column to select the required symbols.

5 Click Import selected variables.

6 Save the project (Project → Save all).
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Getting Started
Data Editor

Introduction
The Data Editor enables you to create Web pages in which the values of variables are displayed 
in a table. In some cases, you can modify these values.
Allowing write access can change system behavior.
NOTE: The Data Editor web page for the BMXP3420•0 CPU modules uses located memory 
addresses only; they are not FactoryCast compatible. Only FactoryCast modules, like the 
BMXNOE0110, BMENOC0311, or BMENOC0321 modules, can be included in a Web Designer 
project that uses Unity Pro symbols.

Selecting Editor Symbols
View and select the available symbols:

WARNING
UNINTENDED OPERATION
 

Password protect access to writable variables.
Grant write access only to trained personnel.
Do not grant write access to critical control variables.

Failure to follow these instructions can result in death, serious injury, or equipment damage.

Step Action
1 In the Navigator pane, expand the project and the target.

2 Right-click DataTables → New Table to view the New Table window.

3 Enter a name for the table in the Table Name field (for example, “Table”).
4 Click OK.
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Getting Started
Select the Table tab, and double-click a row. You can also right-click the Table tab to open the 
contextual menu, and choose New to view the view the configuration zone:

Click the ellipses button (...) to view available symbols in the Lookup window:

Connect variables from the devices to the target:

Step Action

1 Select the symbols you want to monitor.
2 Click OK.

3 Save your table.
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Getting Started
Graphic Editor

Introduction
In the graphic editor window (GDEEditor), you can create Web pages in which the values of 
variables are displayed as graphic objects (buttons, sliders, VU meters, indicators, etc.).
For some graphic objects, you can edit variable values:

You can configure the variable as read-write.
You can grant the intended user(s) password-protected write access to the variable.

In the configuration phase, use the graphic editor to edit and view screens at the same time. In the 
operation phase, you can view only one screen at a time to optimize memory resources.

Using the Graphic Editor
Open the graphic editor (GDEEditor):

Configure the graphic objects:

NOTE: The components of the graphic editor (GDEEditor) are described in detail elsewhere in this 
guide (see page 81).

Step Action
1 Expand (+) the target device in the Navigator pane.
2 Right-click GraphicScreens.
3 Scroll to New Graphic Page to open the GDEEditor.
4 Click the Edit button to view the available graphic objects.
5 From the pull-down menu, select the standard or extended menu to change the available 

graphic objects.
6 Click on a graphic object.
7 Click in the workspace to place the selected graphic object.
8 Repeat these steps to place additional graphic objects in the workspace.

Step Action
1 Double-click a graphic object in the workspace to open its Properties window.
2 Specify parameters in the parameter fields (Name, Address, Data Type, etc.).
3 Click the ellipses (...) button to see the Lookup Variable window.
4 Select the variable that you want to associate with the object.
5 Click OK.
6 Click Done on the Properties window.
7 Click Done in the graphic editor.
8 Click Save in the graphic editor.
9 Enter a name for the graphic.

10 Click OK.
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Using Modicon M580 Graphic Editor
For Modicon M580 projects, the Graphic Editor utilizes Microsoft Silverlight graphics:

Step Action
1 Expand (+) the Modicon M580 target device in the Navigator pane.

2 Right-click GraphicScreens.

3 Scroll to New Silverlight Page → Using Silverlight Graphic Editor.

NOTE: Graphic screens can also be built with any external tool (such as Microsoft Expression 
Blend) when the external tool is configured in Web Designer (see page 129). 

4 In the New Silverlight Page dialog box, enter a name for the new graphic.

5 Click OK:
The new graphic appears in the Navigator pane.
A workspace for the new graphic appears automatically.

6 From the toolbar of available graphics, drag a graphic type and drop it in the workspace.
7 Double-click the graphic icon in the workspace to see the associated configuration options.

8 Configure the graphic.
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Getting Started
Transfer

Introduction
Once you have created a Web site on the configuration PC, you can transfer it to a target.
NOTE: For Modicon M580 modules, disable the User Access rights on the module's FactoryCast 
web pages (Setup → Access Management) to transfer the configuration.

Transfer the Website to a Target
Open the target validation window:

The window appears:

Step Action
1 Select BMX NOE 0110 in the Navigator pane.

2 Open the target validation window (Target → Transfer → PC ->Target).
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Getting Started
NOTE: If the validation process detects errors in your project, the transfer cannot be performed. 
Refer to the Project Validation part (see page 51) for more information.

Step Action

1 Click OK to open the Transfer Status window.
Note: For versions of Web Designer earlier than version 3.0, if there are differences between the 
version of firmware for the project and the target, the transfer cannot be performed. For Web 
Designer version 3.0 and higher, the transfer can be performed if firmware version differences 
exist.

2 Click Transfer.
Result: the Configuration Password window appears if a configuration password has already 
been set. Otherwise the project is transferred.

NOTE: For Modicon M580 modules, this password screen does not exist because the User 
Access rights are disabled before any data is transferred.

3 Click OK to see the Progress Information window. (The files are displayed in the Status Bar.)
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Getting Started
Accessing the Website

Introduction
By now, you know how to use the Web Designer to perform these tasks:

Create a project (see page 19).
Select devices and variables (see page 20).
Create a data table (see page 26) and graphic table (see page 28) to monitor the installation. 
(The data editor and graphic viewer are used to view graphic animation pages related to the 
device variables or internal module variables.)
Transfer your application from the PC to the target (see page 30). Connect to the website to 
complete this step.

The data tables and graphic tables can also be configured on the Web pages associated with the 
module.

Accessing Web Pages
Access the home page of the module by entering its IP address in a browser:

The home page associated with the module appears:

Step Action

1 Open a Web browser.
2 Enter the IP address of the module in the address field. (This example uses the module IP 

address a.b.c.d (see page 48).)
3 Click Go.
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Getting Started
Monitoring Data Tables
On the Monitoring page, click the Data Editor link to open the data editor:

Select the table created previously on the left side of the Data Editor applet and click  to 
launch the animation. This figure shows the data table:
35016149 10/2017 33



Getting Started
Monitoring Graphic Screens

Step Action

1 Click Graphic Viewer on the vertical menu bar of the website to see the animation pages created 
with the Graphic Editor.
The following figure shows the graphics page:
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Chapter 3
Project Management

Introduction
This chapter contains instructions for managing Web Designer projects, including opening and 
closing projects, modifying projects, and importing a project from a file.

What Is in This Chapter?
This chapter contains the following topics:

Topic Page

Adding and Removing Targets 36
Adding and Removing Devices 38

Adding or Removing Items 40

Opening and Closing a Project 41
Importing Projects 42

Importing a FactoryCast Project and Web Site 43
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Project Management
Adding and Removing Targets

The Window
Select a project in the Navigator pane in Web Designer and open the Web Designer Project Wizard 
(Project → New → Target):

This table describes the components of the window:

Component Description

Project This is the project name.
Target List View a list of available targets.

Target This column shows the target types selected in the expanded Target List.
Name This column shows the target names (to distinguish targets of the same type).

Address This column contains the IP address of the target.

> (move) Use this button to add a target to the Selected Target(s) list.
< (remove) Use this button to remove a target from the Selected Target(s) list.
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Project Management
Adding a New Target
Add a target to a Web Designer project:

Removing a Target
To remove a target from the project, right-click the target in the Navigator and scroll to Delete.
NOTE: This action also deletes the files associated with the deleted target (including devices).

Number of Targets
A project can contain a maximum of 16 targets. You can select the same type of target several 
times if you assign a unique name and IP Address for each target.

Step Action
1 In the Target List, select the targets to add.

2 Expand the FactoryCast menu to see the targets that already exist in the project.

3 Click the move button (>) to move the target to the Selected Target(s) list.
4 Enter a name and address for the target.

5 Click Next to continue to the device selection screen.
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Project Management
Adding and Removing Devices

Open the Window
Open the Step 2 window:

Look at the Device List in the Step 2 window:

NOTE: Note that the Web Designer Project Creation Wizard window is already initialized with 
devices that exist in the project. If you have more than one target in your project, select the target 
in the Target List to which you want to attach the device before executing this step.

Step Action

1 In the Navigator pane, expand your project and the target.
2 Highlight the Devices directory.

3 Open the window to add a device (Project → New → Device).

NOTE: You can also right-click the Devices directory and select New Device.
38 35016149 10/2017



Project Management
Fields
This table describes the components of the window:

Adding a Device
Add a device to a Web Designer project:

Removing a Device
To remove a device from the project, right-click the device in the Navigator and scroll to Delete. 
(This action also deletes the files associated with the deleted target.)
NOTE: This action also deletes the variables associated with the Namespace of the device.

Device Selection
You can only select 1 device.

Module Address
For a target in a rack, the wizard presents an empty string as the default address.

Component Description
Target List This is a list of targets that were created in the previous panel (see page 36).
Device List This is a list of available devices.

Selected 
Target(s)/Device(s)

This table contains devices that were selected from the Device List and moved.

Name In this column, give the device a name that distinguishes it from other devices of 
the same type.

Address In this column, give the device a unique IP address.

Protocol This column shows the protocol that the device supports (if the device supports 
more than 1 protocol). (See the note below.)

NOTE: You can associate one or more protocols with each device. If a device supports several protocols, 
the Protocol column is active and the user can choose a protocol from the list. The content of the Address 
column depends on the selected protocol.

Step Action
1 Highlight devices to add from the Device List.

2 Move the highlighted devices to the Selected Target(s)/Device(s) table with the move button (>).
3 In the Name column, enter a name for the device.

4 In the Address column, enter an IP address for the device.

5 Click Finish to verify the addition of the project targets and devices.
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Adding or Removing Items

Introduction
Add these components to you Web Designer project:

data tables (see page 26)
graphic pages (see page 28)
folders (see page 40)
files (see page 40)

Adding a Folder
Add a folder:

NOTE: You can create new folders only in the Website menu tree.

Adding a File
Add a file:

NOTE: You can create new files only in the Website menu tree.

Removing Items
To remove an item from the project, right-click the item in the Navigator and scroll to Delete.

Step Action
1 In the Navigator pane, expand your project and the target.
2 Highlight the Website folder.
3 Open the New Folder window with either of these actions:

Project → New → Folder
Right-click Website and scroll to New → Folder.

Step Action
1 In the Navigator pane, expand your project and the target.
2 Highlight the Website folder.
3 Do one of the following:

For Modicon M580 products (such as the BMENOC0311 and BMENOC0321):
Under the Website node, right click on the Custom folder.
Select New → File.

NOTE: When you right click on the Custom folder, the Import File menu item is also available 
for adding an existing file to the website.

For non-Modicon M580 products, open the New File window with either of these actions:
Project → New → File
Right-click Website and scroll to New → File.
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Opening and Closing a Project

Introduction
Use these directions to open, close, and save Web Designer projects.

Opening an Existing Project
Open an existing project:

Closing an Open Project
Close an open project:

Saving Multiple Modifications
The Save All command saves the modifications made to projects in all open windows. Use one of 
these methods:

Project → Save All
Click the Save All icon in the toolbar.

Quitting Web Designer
Web Designer automatically tracks the opened or closed state of projects when you quit the 
program. When you open Web Designer again, it automatically opens any projects that were open 
when the program was closed.

Step Action

1 View the Open Project window (Project → Open Project).

NOTE: The Open Project window is a list of projects in the workspace.

2 Highlight a project in the Open Project window. 

3 Click Open to see the project in the Navigator pane.

Step Action
1 Highlight a project in the Navigator window. 

2 Close the project (Project → Close Project).
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Project Management
Importing Projects

List of Sources 
Web Designer can import projects in these formats:

.zip file (previously exported by Web Designer)
Web Designer project (outside the Workspace)

Import a Project
Follow these steps:

NOTE: The project appears in the Navigator pane.

Export
You can export a Web Designer project as a .zip file (Project → Export). Use this export command 
when you want to save a project before you modify it. (The project is still open after you export it.)

Step Action
1 Open the Import dialog box (Project → Import):

2 Select an import source.
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Project Management
Importing a FactoryCast Project and Web Site

Introduction
You can import a project (including its embedded web site) into Web Designer if the project was 
created the FactoryCast Configurator tool.

Process
You can perform these steps with the FactoryCast Configurator tool: 

These stages are described in detail below.

Saving the Configurator File
Save a FactoryCast configurator file (.cfg) with the FactoryCast Configurator tool:

Stage Description

1 Save the project as a configurator file (.cfg).
2 Back up the web site as a compressed file (.zip).

3 Import the saved configurator file and the compressed web site with Web Designer.

Step Action

1 Open the project you want to save in the FactoryCast Configurator tool.
2 Open the Save As window (File → Save As).

3 Save the project to a directory.
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Backing Up the Web Site
Back up the web site that is associated with the saved configurator file with the FactoryCast 
Configurator tool:

Importing the FactoryCast Configuration and Web Site
Use Web Designer to import the FactoryCast configuration file and the website that you previously 
saved:

Step Action

1 With the project open in the FactoryCast Configuration tool, open the Backup window (Transfer 
→ Backup):

2 In the Target Host are, enter the Host name or IP address of the device on which the web site 
resides.

3 In the Archive File area, enter the location and name of the file (Path and file name...).

NOTE: You can also click the ellipses (...) to open a window that contains the files.

4 Click OK to close the window.

Step Action
1 In Web Designer, close all open projects.

2 Open the Import window (Project → Import).

3 Select FactoryCast project:

4 Click Next.
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The Import Project From File System window appears:

Follow these steps:

NOTE: You can also click Browse... to navigate and select the files you want to import.

Step Action
1 Enter the path and name of the FactoryCast configuration file you want to import in the Project 

contents field. (See the note below.)
2 From the list of modules, select the Factory Cast module to which you want to import the Factory 

Cast configuration.

3 To import a web site, select Association of Web site. (This step is optional.)

4 In the Zip File field, enter the path and name of the compressed web site files you want to import 
to the selected module. (This step is optional.) (See the note below.)

5 Click Finish.
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Chapter 4
Transferring a Web Site

Introduction
This chapter contains instructions for transferring Web sites. Web sites can be transferred from the 
configuration PC to the module (or vice-versa). The transferred Web pages are generated by the 
Web Designer or created by the user. The transfer can be more general and can include files that 
describe services.

What Is in This Chapter?
This chapter contains the following topics:

Topic Page

Transfer 48

Project Validation 51
Connecting and Disconnecting Web Designer and a Module 55
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Transferring a Web Site
Transfer

Introduction
You can transfer these components from the configuration PC to the target (and vice-versa):

data editor tables
graphic editor pages
services
Web sites (and associated files)

Before the transfer, configure the target IP address. Web Designer validates the structure of the 
project before transferring files to the target. 

Setting Up the IP Address
If two devices have the same IP address, there can be unpredictable operations on your network.

Configure the physical IP address of the module before you transfer a Web site:

NOTE: You can also set the address during the creation of the project with the Creation Wizard.

WARNING
UNINTENDED OPERATION — DUPLICATE IP ADDRESS

Assign the device a unique IP address.
Obtain the IP addresses from your system administrator to avoid the possibility of duplicate 
addresses.

Failure to follow these instructions can result in death, serious injury, or equipment damage.

Step Action

1 Select the target in the Navigator pane in Web Designer.

2 Open the Target Access window (Target → Set Target Address):

3 Enter an IP address in the Address field.

4 Click Validate.
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Transferring from the PC to the Target
Open the target validation window:

The Validation window appears:

NOTE: If the validation process detects errors in your project, the transfer cannot be performed. 
Refer to the Project Validation discussion (see page 51).
Transfer data to the module:

Step Action
1 Select BMX NOE 0110 in the Navigator pane.

2 Open the target validation window (Target → Transfer → PC ->Target).

Step Action
1 Select the target in the Navigator pane.

2 Click OK.
Note: For versions of Web Designer earlier than version 3.0, if there are differences between the 
version of firmware for the project and the target, the transfer cannot be performed. For Web 
Designer version 3.0 and higher, the transfer can be performed if firmware version differences exist.

3 Click OK to open the Transfer Status window.

4 Select the files you want to transfer.

5 Click Transfer. The Configuration Password window appears if a configuration password is already 
set. Otherwise the project is transferred.

6 Enter the configuration password and click OK to open the Progress Information window. (The files 
are displayed one at a time in the Status Bar.)
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Transferring from the Target to the PC
The following table shows how to transfer data from the module to a PC:

Total Transfer of the Project
This function lets you transfer the entire project to the targets associated with it. The transfer is 
done target by target. The global transfer operates in only one direction: you can transfer from the 
PC to the targets, but not from the targets to the PC. To transfer from the targets to the PC, 
manually transfer the files from each target (one target at a time).
To activate the transfer, click Project → Global transfer. The procedure is exactly the same than a 
transfer from the PC to the target (see page 49). 

Partial Transfer
It is possible to do only a partial transfer (to save time). In the Website, gdt (graphic pages), rdt 
(data tables) and Service directories, the contextual menu authorizes a partial transfer limited to 
files located in these directories. In this way, you don’t have to transfer the entire project if you just 
modified a small part.

Documentation
To manage online documentation, the user can add Word (.doc) or Acrobat (.pdf) files to the 
website in the site directory. The Transfer function lets you copy these files to the target.

Site Explorer
The button Site Explorer displays the target files in the lower window. This is especially useful 
before or after a data transfer, in order to analyze the contents of the target.

Step Action
1 In the browser, select the target.
2 Open the Transfer Status window (Target → Transfer → Target ->PC).
3 Select the files you want to transfer.
4 Click Transfer.

Result: the Configuration Password window appears if a configuration password has already been 
set. Otherwise the project is transferred.

5 Enter the configuration password and click OK.
Result: the Progress Information window appears. The files are displayed one at a time in the Status 
Bar.
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Transferring a Web Site
Project Validation

Introduction
Web Designer validates the structure of a project before it transfers the files to a target. If the 
verification detects anomalies, the transfer is canceled. Web Designer also performs a comparison 
between the PC configuration and the target configuration.

Validating a Project
When you start a transfer, Web Designer starts to validate the project. You can also validate a 
project at any time by opening the validation window (Project → Project Validation):

The validation process monitors performs these actions:
The process tells you when the available space on the target is bigger than the size of the 
website.
The validation monitors the use of a user page or service with variables that are not in the 
Namespace file (Namespace.dat).
The validation tells you when the number of variables is more than the maximum number of 
variables (1000) authorized for the target.
The process reports the detection of errors that are related to services.

Click a line with a message to display the details of detected errors.
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Transfer Status
This is the Transfer Status window for Web Designer versions earlier than version 3.0
52 35016149 10/2017



Transferring a Web Site
This is the Transfer Status window for Web Designer versions 3.0 and higher:

The information has not been found on the remote target. 

Inconsistent, non-blocking information between the target and the PC. 

Inconsistent, blocking information between the target and the PC.

Consistent information between the target and the PC. 
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Transferring a Web Site
Use the Selection area to specify the files you want to transfer: 

Parameter Version Action

Transfer Website All Select this box to transfer files located in the Website 
directory.

Transfer Only Modified Files All Select this box to transfer only files of the website that 
have been modified since the last transfer.

Transfer rdt and gdt Files < 3.0 Select this box to transfer data tables (rdt directory) 
and graphic pages (gdt directory).

Transfer rdt Files ≥ 3.0 Select this box to transfer data table (rdt directory).
Synchronize Data Tables with PC ≥ 3.0 Select this box to synchronize data tables (rdt 

directories) in both target and PC.

Transfer Microsoft Blend projects 
Application

< 3.0 Select this box to transfer the Microsoft Blend projects 
application.

Transfer Silverlight Graphics Pages ≥ 3.0 Select this box to include one or both of the following:

Silverlight Pages ≥ 3.0 Select this to transfer Silverlight graphics pages.
Microsoft Blend Application ≥ 3.0 Select this box to transfer the Microsoft Blend projects 

application.
Transfer Configuration Files < 3.0 Select this box to transfer the FactoryCast 

configuration file.
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Connecting and Disconnecting Web Designer and a Module

Introduction
Use the procedure below to execute a Web Designer application after the services are created.
When a project is transferred to a module, the project is erased permanently. Any project that 
exists on the module already is overwritten.
Users with access to Web Designer can modify the value of PLC variables that have been write 
enabled. You can also modify your security settings. Unauthorized or incorrect changes to data can 
change the behavior of your application or process in ways that can be undesirable or hazardous.

NOTE: When an application is in RUN mode, a new project can be used after a module reboot.

WARNING
UNAUTHORIZED SECURITY ACCESS

Do not use default or obvious passwords.
Change your passwords monthly.
Do not use obvious user names.

Failure to follow these instructions can result in death, serious injury, or equipment damage.

CAUTION
LOSS OF DATA
Back up sensitive information before transferring a new application.
Failure to follow these instructions can result in injury or equipment damage.
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Connecting to the Module and Recovering a Project from the Module
Connect Web Designer to the module to recover its application:

Web Designer is now connected to the module.

Disconnecting from the Module
Disconnect Web Designer from the module (Target → Disconnect).

Step Procedure
1 Select the target in the Navigator pane in Web Designer.

2 Connect to the target (Target → Connect → Target).
Web Designer analyses the changes between your project and the module content.
If you have modified the project, the software asks you to transfer the project. Otherwise the 
application moves automatically to online mode.
NOTE: The Configuration Password window appears if a configuration password is already set. 
Otherwise Web Designer connects to the module:

3 Enter the configuration password and click OK.
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Chapter 5
Simulation Mode

Introduction
This chapter describes the simulation mode in Web Designer. You can this mode to debug data 
tables, graphic pages, and services when Web Designer is not connected to a target.

What Is in This Chapter?
This chapter contains the following topics:

Topic Page

Connecting and Disconnecting in Simulation Mode 58
Simulation 59
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Simulation Mode
Connecting and Disconnecting in Simulation Mode

Introduction to Simulation Mode
This topic describes the Simulation mode in Web Designer. This mode lets you execute an 
application without a connection to a target module. Use this mode to test an application on your 
PC before you transfer that application to the module.
NOTE: The graphic and data editors (see page 71) are active in simulation mode, so you can 
modify these pages in simulation mode.
After you make changes in a Web Designer application, you can execute a Partial Transfer to 
reduce transfer time.

Connection
Connect to the Simulation mode in Web Designer and transfer the application to the target:

You are now connected to the simulator with the application in simulation mode.
NOTE: The simulation does not work when an FTP server is running on the system.

Disconnection
Disonnect the Web Designer simulator from a module (Target → Disconnect → Simulation).

Animation of Variables
In Simulation mode, the variables are animated in this manner:

bit: value change (0 or 1)
word: increment step 1

NOTE: The value update frequency depends on the update frequency setting.

Step Procedure

1 Select a target in the Navigator pane in Web Designer.

2 Run the simulator (Target → Connect → Simulation).

NOTE: The operation may run for a few seconds before there is a connection.
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Simulation Mode
Simulation

Introduction
The Simulation mode in Web Designer allows you to verify your configuration and test your 
application on a PC even when devices are not connected or available.
The Simulation mode works with these protocols:

UMAS
UNITE
Modbus

Using the Simulator Icon
In Simulation mode, you can enter relevant values for variables (symbols). Default values are 0. 
Enter these values manually in the window associated with the device. (Double-click the device in 
the Navigator pane.) You can also automatically increment values through these steps:

Using the Simulator for Data Tables and Graphic Pages
Use Simulation mode for data tables:

Step Action

1 In the task bar, right-click the simulation icon .

2 If you check AutoIncrement the variables are automatically incremented.
Uncheck AutoIncrement to stop incrementing the variables. You can modify the value of 
read/write variables.
Check StopServer to stop the simulation.

Step Action
1 Select a target in the Navigator pane in Web Designer.

2 Expand (+) the target directory.

3 Select a table in the DataTables directory.
4 Right-click the selected item and scroll to Open.

Result: An Internet Explorer window appears. Note that the selected table appears in the pane 
on the left.

5 Apply the values to simulate to the variables.
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Simulation Mode
Use Simulation mode for graphics:

Step Action

1 Select a target in the Navigator pane in Web Designer.
2 Expand (+) the target directory.

3 Select a graphic in the GraphicScreens directory.

4 Right-click the selected graphic and scroll to Open to open an Internet Explorer window.
5 Scroll to a graphic in the drop-down menu. This figure shows a graphic being simulated.

6 Apply the values to simulate to the graphic objects.
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Simulation Mode
Using the Simulator for Device windows
Use Simulation mode for device windows:

NOTE: If the AutoIncrement function is checked, the variables are automatically incremented. The 
simulated values are displayed in the Value column. Otherwise, the incrementation of the variables 
stops.
For read/write variables, double-click the Value column to modify the values.

Step Action
1 Select a target in the Navigator pane in Web Designer.

2 Expand (+) the target directory.

3 Double-click a device in the Devices directory to open the device window:

4 Click Animate persistent.
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Chapter 6
Managing Variables

Introduction to Variable Management
This chapter describes the manner in which Web Designer handles variables:

You can import variables from a file that describes a piece of equipment.
You can import a list of variables that are exported to a file from an automated software program.

This chapter also describes grouping of files in a Namespace file. The data and graphics publishers 
as well as services use these variables.

What Is in This Chapter?
This chapter contains the following topics:

Topic Page

Namespace 64

Importing from a Programmable PLC 65
Manually Edit Variables 68

Author Rights in Namespace 69
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Managing Variables
Namespace

Introduction
The Namespace table groups variables (symbols) that have been selected for targets or devices. 
Data editors, graphic editors, and services get symbols from the Namespace table.
Variables come from connected devices or PLC applications. If you connect a device type to the 
same target several times, create a unique name in this format: device.name, variable name. If the 
device is a PLC, create names for variables declared in the PLC in this format: PLC device.name, 
PLC variable name.

Accessing the Namespace
Open the Namespace window:

The Namespace window is open:

Step Action
1 Select a project in the Navigator pane in Web Designer.

2 Expand the target directory by clicking the plus sign (+).

3 Double-click the Namespace icon.
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Importing from a Programmable PLC

Introduction
You can access a Unity Pro database with the Import Symbols command in Web Designer.
NOTE: Depending on the devices that you connect to the target, the type of variable you can 
access through the target might be different. Refer to the FactoryCast for Modicon M340 User 
Manual or FactoryCast for Premium and Quantum User Manual for more information on supported 
variables.

Accessing the Software Database
Open the list of devices:

View the list of devices:

Step Action

1 Select a project in the Navigator pane in Web Designer.

2 Expand the target directory by clicking the plus sign (+).

3 Expand the Devices directory.

4 Double-click a device in the Devices directory.
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Window Elements
This table describes the components of the devices window:

Importing Symbols
Import symbols:

Feature Description
Column Symbol The symbol serves as the name of the variable.

Variable This column lists the register address of the variable.

Type This column lists the data type of the variable (BOOL, INT, etc.).
Access Access to the variable is read, write, etc.

Persistent The access mode to the variable is constant (not configurable).

Rate The variable is refreshed at this interval.
Value This is the value of the current variable.

Button Remove Delete the variable.
Duplicate Duplicate the variable.

Import PLC Symbols Open a selection window of variables.

Import from CSV Import the variables from a CSV file.
Export to CSV Export the variables to a CSV file.

Step Action

1 Click the Import PLC symbols button to open an Explorer window:

2 Select a file (.stu or .xvm) to import.
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Accessing the Unity Pro Base
To access a Unity Pro database, install the Unity Pro software on your computer. Unity Pro 
database files have the extension .stu. You can also use a Unity Pro export file (extension .xvm). 
In the latter case, the installation of Unity Pro is not required.

Synchronization with the PLC Program
It is possible to modify the Unity Pro database from which you created your Namespace at any 
time. The Web Designer Configuration Program alerts you to any differences between the 
database and your Namespace when you open a configuration that is associated with the PLC 
database file.

Synchronization
Synchronize with a PLC database:

3 Click Open to view the symbols:

4 Select symbols.

5 Double-click variables in the list to select them.

6 Click Import selected variables to view the variables in the device window.

Step Action

Step Action
1 Open a window to view the inconsistencies in a window (Target → Synchronize with PLC 

database).
2 Click OK to start the default resynchronization operation. 
3 Transfer the project to the module.
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Manually Edit Variables

Introduction
You can manually add variables by directly entering a symbol, an address, its type and define the 
access rights in the Variables dialog of each device.
NOTE: Depending on the devices that you connect to the target, the type of variables you can 
access through the target might be different. 

Automatic Input
Automatic Input is an option that makes it easier to manually create variables by incrementing the 
value of the last record.
If you select this option, the value of the fields is automatically filled when you add a new variable. 
The values correspond to those of the previous line incremented by 1.
Activating / Deactivating Automatic Input:
Options → Automatic Input
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Author Rights in Namespace

Introduction
The Namespace table in the Web Designer software enables you to specify the variables that can 
be accessed in read/write mode.
NOTE: The default password for write access is USER.
Unauthorized or incorrect changes to data may change the behavior of your application in ways 
that may be undesirable or hazardous.

Managing Author Rights 
Use these steps to manage access rights:

WARNING
UNINTENDED EQUIPMENT OPERATION
Carefully select the variables (symbols) and the direct addresses you authorize to be modified 
online, and the people authorized to do so.
Failure to follow these instructions can result in death, serious injury, or equipment damage.

Step Action

1 Expand a project in the Navigator pane in Web Designer by clicking the plus sign (+).

2 Expand a target in the Navigator pane.
3 Double-click Namespace Write Access to open the Namespace author rights table:

NOTE: You can also open this window by right-clicking Namespace Write Access → Open.

4 Define the intervals at which variables can be written. Outside these intervals, variables with 
direct access are read-only.
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Chapter 7
Monitoring

Subject of this Chapter
This chapter presents the different ways provided by Web Designer to monitor your system.

What Is in This Chapter?
This chapter contains the following sections:

Section Topic Page
7.1 Data Editor 72

7.2 Graphic Editor 81
7.3 Adding Microsoft Silverlight® Pages 120

7.4 PLC Program Viewer 121
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Data Editor

Section 7.1
Data Editor

Overview
The Data Editor allows you to edit/create data monitoring tables or to display data tables. Data 
tables provide read/write access to application data and device registers. Write access is password 
protected.
Allowing write access can change system behavior.

This section shows how to use the Data Editor to display and modify the values of the symbol 
variables and direct addresses.

What Is in This Section?
This section contains the following topics:

WARNING
UNINTENDED SYSTEM OPERATION

Help protect the access to writable variables by configuring passwords.
Grant write access only to trained personnel.
Do not grant write access to critical control variables.

Failure to follow these instructions can result in death, serious injury, or equipment damage.

Topic Page

Data Editor 73
Data Editor Components 74

Creating a Data Template 76
Inserting a Symbol (Variable) in a Data Template 77

Inserting a Direct Address in a Data Template 79

Using an Existing Data Template 80
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Data Editor

Introduction
The data editor is a Java applet that enables you to create dynamic data tables that can be updated 
with run-time data from the PLC.

View the Data Editor
This is the data editor in Web Designer:

NOTE: The configuration fields (Name, Address, Read only, etc.) are visible after you double-click 
on a table row.
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Data Editor Components

Introduction
This topic describes the different options on the data editor window (see page 73).

Configuration
Double-click in any table row to make view other fields (Name, Address, Type):

select and/or modify a name
select and/or modify an address
select the variable type
select the variable’s format
check the read-only option

This table describes the configurable fields:

NOTE: The columns that are relevant to different targets may not match those listed in the table.

Column Description
Name The Name field contains the name of a symbolic variable from the Namespace file. 

Available variables are those that have been predefined in the configuration tool and 
grouped in the Namespace file.

Address The Address column contains the addresses of the symbols. You can display any direct 
address by entering its reference in this field. This direct address does not need to be 
referenced in Namespace, but it needs to be associated with a symbol.

Type Data type (see page 75): input or output register, input or output bit.
Format Format (see page 75) of the data value.

Read only Check this box to limit a variable to read-only access.
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Type
The Type scroll bar contains the data type of the symbol variable or direct address. The types of 
data of the symbolic variable appear automatically when the symbol variable is located. Scroll to 
one of these data types:

Format
The Format scroll bar contains the format type for the value of the symbol variable or direct 
address. These types are available:

Status Field
The Status column contains messages about the status of communications with the symbol 
variable or direct address. When communications are normal, the status message is "OK".
If communication with a simple variable or a direct address is not operational, the Status column 
displays a message describing the event.

Abbreviation Type

INT 16-bit signed integer
UINT 16-bit unsigned integer

DINT 32-bit signed integer
UDINT 32-bit unsigned integer

REAL 32-bit IEEE floating point

TIME 32-bit unsigned integer (ms)
DATE Date (32-bit BCD)

TOD Date/time (32-bit BCD)

BOOL 1 internal bit (boolean)

Abbreviation Format Type
bool boolean

dec decimal

hex hexadecimal
binary binary

ASCII bytes (ASCII characters)

time Day_hr_min_sec_ms
date YYYY-MM-DD or HH:MM:SS
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Creating a Data Template

Introduction
To display some symbols (variables) in Web Designer, create a new data template.

Creating a Data Template
Use these steps:

NOTE: Save the current spreadsheet before you select a new spreadsheet. Selecting a new 
spreadsheet deletes the current table.

Step Action

1 Expand a project in the Navigator pane in Web Designer by clicking the plus sign (+).

2 Right-click the DataTables directory and scroll to New Table to open the New Table window:

3 Enter a name for the new data template in the Table Name field.

4 Click OK.
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Inserting a Symbol (Variable) in a Data Template

Overview
To view or modify the value of a symbol (variable) in the Namespace, insert that symbol (variable) 
in a data template.
To modify these values, users need write privileges to the embedded server. Changing symbol 
values can change system behavior.

WARNING
UNINTENDED EQUIPMENT OPERATION

Password-protect access to the embedded server.
Carefully select the symbols and direct addresses you authorize to be modified online.
Do not authorize online modifications of critical process variables.

Failure to follow these instructions can result in death, serious injury, or equipment damage.
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Inserting a Symbol (Variable)
Use these steps to insert a symbol (variable):

Step Action
1 Double-click an empty row in the spreadsheet to see the configuration options.

2 In the configuration area, click the ellipses (...) button to open the Lookup table:

3 Select the symbols to insert in the data template one at a time. (You can click Select All to select 
all listed variables.

4 (Optional) If you select Read Only for a selected variable, that variable can be read (but not written 
to) when accessed (via the module web pages).

5 Click Import Selected Variables to see new rows for the symbols (variables) you selected.

6 Save your data table.
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Inserting a Direct Address in a Data Template

Presentation
If you want to view or modify the value of a direct address, insert that direct address in a data 
template.
Allowing write access can change system behavior.

Inserting a Direct Address

WARNING
UNINTENDED EQUIPMENT OPERATION

Limit embedded server access to qualified personnel.
Restrict access to the embedded server by configuring passwords.
Carefully select the symbols and direct addresses you authorize to be modified online.
Do not authorize online modification of variables that can adversely affect human and material 
integrity.

Failure to follow these instructions can result in death, serious injury, or equipment damage.

Step Action
1 Double-click an empty row in the spreadsheet.

Result: The data editor’s configuration area appears. 
2 In the Address field of the configuration area, enter the variable’s direct address.

3 In the configuration area, click Apply.
Result: A new row that corresponds to the variable address is displayed in the spreadsheet.
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Using an Existing Data Template

Overview
After you create templates in the data editor in the Web Designer software, you can access and 
modify those templates. 

Accessing a Data Template
Access an existing data template.

Step Action

1 Extend the DataTables directory in the Navigator to see existing tables.
2 Access the table for editing. Use one of these methods:

Double-click the table you want to modify in the list.
Right-click the table you to modify and scroll to Edit.
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Graphic Editor

Section 7.2
Graphic Editor

Introduction
This section describes the functions and characteristics of the graphic editor. The graphic editor is 
a Web page that enables the user to create dynamic graphic displays using a predefined set of 
graphic objects. It is both a graphic editor that can be used to create and modify displays and a 
runtime environment that allows the user to view animated displays using data from the PLC. To 
limit the size of the applet, only the viewer is accessible from the module’s website.

What Is in This Section?
This section contains the following topics:

Topic Page

Introducing the Graphic Editor 82
Graphic Editor Toolbar 84

User Functions in the Display Window 88

Properties Sheet 90
Security 91

Graphic Editor Applet Parameters 92
Graphic Objects 93

Extended Graphic Objects 110
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Introducing the Graphic Editor

Graphic Editor Window
This is the graphic editor in Web Designer:

This table describes the components of the graphic editor:

The controls in the top dialog box provide the following functions.
Delete: Click the Delete button to open the Delete dialog box. This button is disabled until you 
enter a correct password or save the current graphic display.
Information display area:The information display area shows the name and version of the 
Concept, PL7 or Unity Pro program that is running in the connected PLC.

Feature Description

control 
options

drop-down list A drop-down list shows the graphic pages that have been saved. You can 
retrieve those pages. When you select a graphic page from this list, the 
graphic display currently visible in the window is replaced with the one 
selected. If the current graphic page has been modified since it was last 
saved, confirm that the changes can be discarded. Choose <new> from the 
list to clear the display window and create a new graphic page.

Save... Click the Save button to open a save dialog box. (This button is disabled until 
you enter a valid write-enabled password.)

Edit... Press Edit... to access graphic editing features.

workspace The white window contains the current graphic display. You can add graphic elements to this 
space.

message 
area

The bottom window contains messages generated by the graphic editor.
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Graphic Objects
The graphic objects supplied with the graphic editor can communicate with the Modbus devices 
from which the graphic editor was downloaded. There is no additional "wiring" between graphic 
objects and "communication objects." The graphic objects are designed as standalone objects, 
which means that no connection is needed between the objects. Each object can operate on its 
own.
Allowing write access can change system behavior.

NOTE: Write access is controlled by a password whose default value is USER.

Creating and Modifying Graphic Displays
To create and modify a graphic page, click Edit. The standard functions of the graphic editor are 
displayed. With these tools, you can select objects from a palette, position them in an area, move 
and resize them with the mouse, and define their properties. You can immediately test the graphic 
display modified with the execution data from Modbus devices by clicking Done to leave the editing 
mode. When you are satisfied with the graphic display, save it to the module for later use (click 
Save). This requires the correct password.
NOTE: Be careful when you modify and save a graphic page. When modifications are saved, the 
existing page is overwritten, even if someone else has created it.

User Functions
Most user functions in the graphic editor are in the top window (see page 84). You can modify the 
size and position of a graphic object directly in the display window. The properties of a graphic 
object (such as its scale, labels, colors, and Uni-Telway execution data device addresses) are 
defined in the properties sheet (see page 90).

WARNING
UNINTENDED EQUIPMENT OPERATION

Restrict access to the embedded server by configuring passwords.
Carefully select the symbols and direct addresses you authorize to be modified online.
Do not authorize online modification of variables of critical nature concerning human and 
material integrity.

Failure to follow these instructions can result in death, serious injury, or equipment damage.
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Graphic Editor Toolbar

Introduction
This topic describes some features of the graphic editor in Web Designer.

Standard and Extended Toolbars
In the Web Designer graphic editor, click the Edit... button to scroll to see the toolbar. In the scroll 
box, select either the standard (default) or extended panel of the graphic editor.
This is the standard panel of the graphic editor:

This is the extended panel of the graphic editor:

Save
Click the Save button to save the current graphic display to the Web server module.
When you click Save, a dialog box appears. Enter a name in the empty name field (save graphic 
display as:) and press OK. (If the graphic display has already been saved, the name is already 
displayed. Saving in this case is a virtual “save as” command.)
Click Cancel if you don’t want to save the graphic display.

Delete Dialog
The Delete dialog box allows you to delete the current graphic page.

If you click Yes, the existing graphic display window is cleared and the graphics file on the Web 
server module is deleted. Clicking No will cause the Top dialog box to be shown again, with no 
action being taken.
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Password Dialog
The Password dialog box allows you to enter the password that enables those user functions that 
modify graphic display files or PLC run-time data values.

If you enter the correct password and click OK, you can save and delete the current graphic 
display. Correct password entry also permits you to write new values to the PLC (via those graphic 
objects that support writing values to a PLC, if any). If you click OK when the text field is empty, 
then the current password permissions, if any, are cleared. The Cancel button brings you back to 
the top dialog box. In this case, no changes are made to current password permissions.

Edit Dialog
The Edit... dialog box allows you to create or modify a graphic page, by selecting a graphic object 
for placement in the display window, and accessing all the graphic editing functions. The graphic 
objects available are presented in a single object palette:

The controls of the Edit provide the following functions:
The drop-down list contains the available palettes. When you select the name of a palette from 
the list, the palette area of the dialog displays the selected one’s graphic objects.
The dialog box shows the graphic objects that are in the current palette with an icon that depicts 
each graphic object's type (meter, button, etc.). When you click any of the icons in the palette, 
a graphic object of the corresponding type becomes selected for insertion. While the Graphic 
Editor is in "insert mode," if you click in an open area of the display window, an instance of the 
selected graphic object is inserted into the graphic display.
A white information box in the toolbar shows the name and size of the graphic object that is 
currently selected.
Click Cut to remove the selected graphic object(s) from the graphic display and saved it to a 
buffer (an internal clipboard). (This replaces the content of the buffer.)
Click Copy to copy the selected graphic object(s) to the buffer. (The copied item replaces the 
content of the clipboard.)
Click Paste button causes the content of the clipboard to be inserted into the upper left corner 
of the graphic display. The pasted graphic objects can then be moved to the desired location in 
the display.
Click Properties to view the properties sheet (see page 90) for the selected graphic object.
Click Customize to view the Customizer for the selected object (if the graphic object has a 
Customizer).
Click Layout to view the Layout dialog box.
Click Options to view the Options dialog box.
Click Done to return to the top dialog box.
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Layout Dialog
The Layout dialog box allows you to change the position and size of a group of graphic objects:

This table describes the components of the Layout window:

NOTE: For all layout operations (except Space evenly), one of the selected objects is the 
“reference object.” Other selected objects have a location and size in relation to the reference 
object. For example, click the Width button to change the width of selected objects to match the 
width of the reference object. The reference object is not the same color as other objects.

Button Description
Right Use these buttons to align the edges of multiple selected graphic objects.

Bottom

Left
Top

Horizontally Use these buttons to evenly space and distribute the centers of multiple graphic objects.

Vertically
Horizontally

Vertically
Width Use these buttons to assign uniform dimensions to multiple selected graphic objects.

Height

Done Click this button to return to the top dialog box.
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Options Dialog
The Options dialog box is used to change the settings related to a grid in the display window. The 
grid is solely for assistance in editing or creating a graphic display and is shown only when the 
Graphic Editor is in "edit mode":

This table describes the components of the Options window:

Component Description
Grid column width The cell size of the grid can be changed by the entering the grid's column width 

and row height into the dialog's text fields.Grid row height

Show grid Check this box to place a grid under the objects in your graphic display.
Snap to grid Check this box to make the size and position of graphic objects conform to points 

on the grid.

OK Click this button to enable the current option settings. This returns you to the Edit 
dialog box.

Cancel Click this button to cancel changes and return to the top dialog box.
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User Functions in the Display Window

Introduction
Add graphic objects in the graphic editor window in Web Designer. You can move and resize 
selected objects in the workspace. This is an example of a graphic display:
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Selecting Graphic Objects
Use these tips to select and deselect graphic objects:

Sizing Graphic Objects
To resize a graphic object, left-click the border or corner of the object and drag the mouse.

Moving Graphic Objects
Hold down the left mouse button on a graphic object and move the mouse to move the object in 
the workspace.

Defining Graphic Object Properties
You can define the properties of a graphic object using the property sheet (see page 90). If this 
window is displayed, you can modify the properties of the selected graphic object. Click 
Properties... or double-click on an object to see the property window.

Customizing Complex Graphic Objects
Use a customization module to configure complex graphic objects when the property sheet is not 
adequate or too cumbersome. The customization module is a dialog box designed specially for 
configuring the graphic object with which it is associated. When the graphic editor detects a 
customization module associated with the selected graphic object, the Customize... button is 
enabled so that the module can be accessed. When you double-click a graphic object that has an 
associated customization module, the module is displayed instead of the properties sheet. If a 
graphic object has an associated customization module, only its name is displayed in the 
properties sheet.

Display Background Image
The Background image property of the graphic editor allows you to choose an image that will be 
used as the background for the display. The image may be a .gif file or a .jpeg file. Refer to the 
Adding Images part (see page 112) for information on adding images.

Goal Action
Select an object. Left-click a graphic object to select it.

Left-click in an empty area of the workspace and drag-and-release the mouse to 
select any object(s) in the outlined area.

Hold down the CTRL key to select multiple objects.

Change the reference 
object (see page 86).

Hold down the SHIFT key when multiple objects are selected and left-click the 
intended reference object.

Deselect an object. Left-click in an empty area of the workspace or any other object.
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Properties Sheet

Introduction
The Properties sheet is a floating dialog box that contains the configurable properties of graphic 
object. Double-click on an object too see its properties:

The properties of a graphic object are specific to the object type. They are contained in a drop-
down list, and are identified by a name and value. The graphic editor provides a description of the 
graphic objects (see page 93).

Lookup Variables Table
In the Address field, you can enter the address of a variable.Click the ellipses (...) button to see the 
Lookup Variable table for the address of the graphic object. The table contains a list of symbols 
(variables) that have been Web-enabled in Web Designer. You can select one of these symbols:
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Security

Security
Three security elements are provided to help you protect your data:

The HTML page which contains the Graphic Editor applet has been placed in the secure 
directory on the Web module. The Web browser user is therefore invited to enter a password 
which will allow him/her to download the HTML page.
The Password dialog enables you to save/delete files or to transfer data values. The dialog is 
password-protected. When you transfer of data values, the Graphic Editor reinforces the read 
only mode by deactivating the user commands relating to graphic objects.
The Graphic Editor allows you to indicate if an element is read only. The Graphic Editor 
reinforces the read only attribute of a symbol (variable) or address by rejecting any request 
which would define a new data value and by informing the user via the Graphic Editor message 
window.

For example, say you have programmed a pushbutton object to jog a motor when the button is 
depressed and to stop jogging when the button is released. If communications are lost while the 
button is depressed, the motor will continue to jog even when the button is released. Graphic 
objects should not be used to control situations such as this unless other interlock methods are 
installed in the system.

WARNING
UNINTENDED EQUIPMENT OPERATION

Do not use graphic objects in situation where loss of communication to the FactoryCast 
module can affect human or material integrity. 
Do not use graphic objects in safety critical machine functions.

Failure to follow these instructions can result in death, serious injury, or equipment damage.
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Graphic Editor Applet Parameters

Overview
Three applet parameters allow the Graphic Editor behavior to be customized. These are defined 
by the <PARAM> tags inside the <APPLET> tag on the Graphic Editor HTML page. The 
parameters recognized by the Graphic Editor applet are as follows:

LOAD: this parameter asks the Graphic Editor to automatically load a specific graphic file at 
start-up. If this file does not exist, a message is displayed. If this parameter does not appear in 
the <APPLET> tag, no file will be automatically loaded at start-up. In this case, select an initial 
graphic file from the list proposed by the Graphic Editor.
MODE: this parameter asks the Graphic Editor to start either in Edit (normal mode) or View 
mode (specific mode). When starting in View mode, the Graphic Editor only displays the display 
window. When this parameter is used with the LOAD parameter, you can design a website with 
HTML pages dedicated to specific graphic display. The user does not need to select a graphic 
file so the behavior of the HMI screen is more standard. This parameter may take the following 
values:

EDIT (default value): The Graphic Editor starts up in Edit mode (normal mode).
VIEW_RO: The Graphic Editor starts up in View mode (read only). The Web browser user is 
not authorized to send data values to Modbus devices.
VIEW_RW: The Graphic Editor starts up in View mode (read/write). The Web browser user 
is authorized to send data values to Modbus devices after having entered the password to 
allow write access.

AUTO_LOGIN: this parameter asks the Graphic Editor to automatically indicate the password 
which authorizes write access to Modbus devices. If the MODE parameter is set to VIEW_RW 
or EDIT, and if you set AUTO_LOGIN to TRUE, the Graphic Editor authorizes write access to 
Modbus devices without asking the user to enter a password. This parameter may take the 
values FALSE (default value) and TRUE.

Example
Here is an example of an <APPLET> tag which asks the Graphic Editor to start in View mode and 
automatically load a graphic file called UNIT_1. In this case, the Web browser allows you to send 
values to Modbus devices via any graphic object handling the sending of values (providing that the 
password to allow write access has been entered).
<APPLET codebase="/classes"
archive="SAComm.jar,GDE.jar,Widgets.jar"
code="com.schneiderautomation.gde.GdeApplet"
width="700" height="514">
<PARAM name="LOAD" value="UNIT_1">
<PARAM name="MODE" value="VIEW_RW">
<PARAM name="AUTO_LOGIN" value="FALSE">
</APPLET>
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Graphic Objects

Introduction
Use graphic objects offered by the graphic editor help you to create graphic displays imitating 
conventional instrument panels. The data control and monitoring objects have integrated 
communication functions and are designed as standalone graphic objects.
Be aware, however, that if communication to the device linked to the graphic object is lost, the 
object becomes inoperative without the end device's knowledge.
For example, say you have programmed a pushbutton object to jog a motor when the button is 
depressed and to stop jogging when the button is released. If communications are lost while the 
button is depressed, the motor will continue to jog even when the button is released. Graphic 
objects should not be used to control situations such as this unless other interlock methods are 
installed in the system.

In addition, the objects in the graphic editor exist in the form of applets to help clients who wish to 
insert several simple applets into a single HTML page. When combined with the LiveBeanApplet, 
the graphic objects in the graphic editor can be used in the same way as the LiveLabelApplet.

Horizontal Indicator
A horizontal indicator gives an analogue representation of the value of a variable in a device. This 
is a horizontal bar which represents a percentage of its range in physical units. It is possible to 
display the value’s digital indication in the centre of the bar.
This table describes the horizontal indicator’s properties:

WARNING
UNINTENDED EQUIPMENT OPERATION
Do not use graphic objects in situations where loss of communication to the module can put 
human integrity or material damage at risk.
Failure to follow these instructions can result in death, serious injury, or equipment damage.

Property Description Limits
Name Name of the graphic object –

Address Direct address of the variable to monitor Note 1 (see page 109)
Data Type Variable data type Note 2 (see page 109)
Background Graphic object background color –

Label Label to be displayed as part of the graphic object
Label Color Color of the label

Label Font Font used for the label
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Major Scale 
Divisions

Number of major scale divisions (marked) 0...100

Minor Scale 
Divisions

Number of minor scale divisions (not marked) 0...100

Scale Color Color of the scale and its labels –

Scale Font Font used for the scale labels
Scale Precision Number of decimal places to be shown for the scale labels 

(set to -1 to use a general exponential format)
-1...6

Maximum EU Value Maximum value of the variable in physical units –

Minimum EU Value Minimum value of the variable in physical units
Maximum Value Maximum gross value (without scale) of the device variable Note 3 (see page 109)
Minimum Value Minimum gross value (without scale) of the device variable Note 3 (see page 109)
Value Visible Indicates if there should be digital display of the value on the 

scale
–

Value Font Font used for digital display of the value (where this exists)
Bar Background Background color of the indicator bar

Bar Color Color of the indicator bar (if the scale value is within the 
High/Low range)

High High Limit 
Value

Value expressed in physical units of the "High High" limit.

High High Limit 
Color

Color of the indicator bar if the scale value is greater than 
the "High High" limit

High Limit Value Value expressed in physical units of the "High" limit.
High Limit Color Color of the indicator bar if the scale value is greater than 

the "High" limit.
Low Limit Value Value expressed in physical units of the "Low" limit

Low Limit Color Color of the indicator bar if the scale value is less than the 
"Low" limit

Low Low Limit 
Value

Value expressed in physical units of the "Low Low" limit

Low Low Limit Color Color of the indicator bar if the scale value is less than the 
"Low Low" limit

Limit Deadband Neutral range (as a percentage of the EU range) to apply to 
verification of the High/Low limit

0...10

Border Width Width (in pixels) of the graphic object border 0...32
Border Color Color of the graphic object border –

Value Simulated gross starting value (without scale) for testing the 
graphic object

Note 3 (see page 109)

Property Description Limits
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Vertical Indicator
A vertical indicator gives an analogue representation of the value of a variable in a device. This is 
a vertical bar which represents a percentage of its range in physical units.
This table describes the vertical indicator’s properties:

Property Description Limits
Name Name of the graphic object –
Address Direct address of the variable to monitor Note 1 (see page 109)
Data Type Variable data type Note 2 (see page 109)
Background Graphic object background color –
Label Label to be displayed as part of the graphic object
Label Color Color of the label
Label Font Font used for the label
Major Scale Divisions Number of major scale divisions (marked) 0...100
Minor Scale Divisions Number of minor scale divisions (not marked) 0...100
Scale Color Color of the scale and its labels –
Scale Font Font used for the scale labels
Scale Precision Number of decimal places to be shown for the scale labels 

(set to -1 to use a general exponential format)
-1...6

Maximum EU Value Maximum value of the variable in physical units –
Minimum EU Value Minimum value of the variable in physical units
Maximum Value Maximum gross value (without scale) of the device variable Note 3 (see page 109)
Minimum Value Gross minimum value (without scale) of the variable in the 

device
Note 3 (see page 109)

Bar Background Background color of the indicator bar –
Bar Color Color of the indicator bar (if the scale value is within the 

High/Low range)
High High Limit Value Value expressed in physical units of the "High High" limit.
High High Limit Color Color of the indicator bar if the scale value is greater than 

the "High High" limit
High Limit Value Value of the "High" limit expressed in physical units
High Limit Color Color of the indicator bar if the scale value is greater than 

the "High" limit.
Low Limit Value Value of the "Low" limit expressed in physical units
Low Limit Color Color of the indicator bar if the scale value is less than the 

"Low" limit
Low Low Limit Value Value of the "Low Low" limit expressed in physical units
Low Low Limit Color Color of the indicator bar if the scale value is less than the 

"Low Low" limit
Limit Deadband Neutral range (as a percentage of the EU range) to apply to 

verification of the High/Low limit
0...10
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Horizontal or Vertical Slider
A horizontal or vertical slider gives an analogue representation of the value of a variable in a 
device. This is a slider, whose position is indicated by the cursor, which represents a percentage 
of its range in physical units. Using the mouse, you can change the value of the slider by sending 
a new value to the device.
This table describes the properties of the horizontal and vertical sliders:

Border Width Width (in pixels) of the graphic object border 0...32
Border Color Color of the graphic object border –
Value Simulated gross starting value (without scale) for testing the 

graphic object
Note 3 (see page 119)

Property Description Limits

Property Description Limits
Name Name of the graphic object –
Address Direct address of the variable to monitor  1 (see page 119)
Data Type Variable data type Note 2 (see page 109)
Background Graphic object background color –
Label Label to be displayed as part of the graphic object
Label Color Color of the label
Label Font Font used for the label
Major Scale Divisions Number of major scale divisions (marked) 0...100
Minor Scale Divisions Number of minor scale divisions (not marked) 0...100
Scale Color Color of the scale and its labels –
Scale Font Font used for the scale labels
Scale Precision Number of decimal places to be shown for the scale labels 

(set to -1 to use a general exponential format)
-1...6

Maximum EU Value Maximum value of the variable in physical units –
Minimum EU Value Minimum value of the variable in physical units
Maximum Value Maximum gross value (without scale) of the device variable Note 3 (see page 119)
Minimum Value Minimum gross value (without scale) of the device variable Note 3 (see page 119)
Block Increment Amount by which the scale value is modified when the user 

clicks on the bar’s slide area.
–

Unit Increment Amount by which the scale value is modified when the user 
clicks on the slider arrows

Border Width Width (in pixels) of the graphic object border 0...32
Border Color Color of the graphic object border –
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Horizontal or Vertical Selector
A horizontal or vertical selector allows you to choose from a number of options. Once the selection 
has been made, the value corresponding to the choice is sent to the device. The choices are 
represented by the marks on a "scale", the current selection being indicated by the position of the 
cursor on a slider.
This table describes the properties of the horizontal and vertical selectors:

Digital Indicator
A digital indicator gives a digital representation of the value of a variable in a device. The value may 
be displayed in different formats and may be set to change color when a predefined high or low 
limit is exceeded.
This table describes the properties of the digital indicator:

Property Description Limits
Name Name of the graphic object –

Address Direct address of the variable to monitor Note 1 
(see page 109)

Data Type Variable data type Note 2 
(see page 109)

Background Graphic object background color –
Choices Selector choices Each choice is indicated in the form of a 

"label=value" input (when you select a "label", the "value" is sent 
to the device).

At least two 
choices required

Label Label to be displayed as part of the graphic object –
Label Color Color of the label

Label Font Font used for the label
Scale Visible Indicates if a "scale", labeled with the choices should be displayed

Scale Color Color of the scale and its labels

Scale Font Font used for the scale labels
Border Width Width (in pixels) of the graphic object border 0...32

Border Color Color of the graphic object border –

Property Description Limits
Name Name of the graphic object –

Address Direct address of the variable to monitor Note 1 (see page 109)
Data Type Variable data type Note 2 (see page 109)
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Background Graphic object background color –

Label Label to be displayed as part of the graphic object
Label Color Color of the label

Label Font Font used for the label

Value Format Format (decimal, hexadecimal, etc.) to be used to display 
the value on the scale

Value Precision Number of decimal places to be shown for the value on 
the scale (set to -1 to use a general exponential format)

-1...6

Value Background Background color of the value’s display zone –

Value Color Color of the value’s digital display text

Value Font Font used for digital display of the value
Units Label of the value’s physical units (attached to the value’s 

digital display)
Maximum EU Value Maximum value of the variable in physical units

Minimum EU Value Minimum value of the variable in physical units

Maximum Value Maximum gross value (without scale) of the device 
variable

Note 3 (see page 119)

Minimum Value Minimum gross value (without scale) of the device 
variable

Note 3 (see page 119)

High High Limit Value Value of the "High High" limit expressed in physical units –

High High Limit Color Color of the indicator bar if the scale value is greater than 
the "High High" limit

High Limit Value Value of the "High" limit expressed in physical units

High Limit Color Color of the indicator bar if the scale value is greater than 
the "High" limit.

Low Limit Value Value of the "Low" limit expressed in physical units
Low Limit Color Color of the indicator bar if the scale value is less than the 

"Low" limit
Low Low Limit Value Value of the "Low Low" limit expressed in physical units

Low Low Limit Color Color of the indicator bar if the scale value is less than the 
"Low Low" limit

Limit Deadband Neutral range (as a percentage of the EU range) to apply 
to verification of the High/Low limit

0...10

Border Width Width (in pixels) of the graphic object border 0...32
Border Color Color of the graphic object border –

Value Simulated gross starting value (without scale) for testing 
the graphic object

Note 3 (see page 119)

Property Description Limits
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Message Display
A message display shows a text message based on the value of a variable in a device. For each 
specified message, a set value triggers its display.
This table describes the properties of the message display:

Push Button
When activated with the mouse, a push button allows you to send one or more preset values to a 
device.
This table describes the properties of the push button:

Property Description Limits
Name Name of the graphic object –
Address Direct address of the variable to monitor Note 1 (see page 109)
Data Type Variable data type Note 2 (see page 109)
Background Graphic object background color –
Messages The messages to be displayed. A "value=text" input 

corresponds to each message (when the device value is 
equal to "value", the "text" message is diplayed).

At least one message 
required

Message Background Background color of the message display zone –
Message Color Message text color
Message Font Message text font
Label Label to be displayed as part of the graphic object
Label Color Color of the label
Label Font Font used for the label
Border Width Width (in pixels) of the graphic object border 0...32
Border Color Color of the border of the graphic object –
Value Simulated input value for testing the graphic object Note 3 (see page 109)

Property Description Limits
Name Name of the graphic object –
Address Direct address of the variable to monitor Note 1 

(see page 109)
Data Type Variable data type Note 2 

(see page 109)
Background Background color of the graphic object –
Values Values to send to the device Note 4 

(see page 109)
Reset Values Values to send to the device once the reset delay has expired. 

If no reset value is given, the reset will not take place.
–
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Direct Output Station
The direct output station allows you to enter a digital value in a text zone directly from the keyboard. 
If the value entered is between the upper and lower preset limits, a Set button is activated. In this 
case, the value entered is sent to the device when you click Set or press ENTER (if keyboard input 
is authorized for the input zone).
This table describes the properties of the direct output station:

Reset Delay Delay (in milliseconds) that the push button waits between 
sending the values to the device and sending the reset values

0...2000

Label Label to be displayed as part of the graphic object –
Label Color Color of the label
Label Font Font used for the label
Button Label Text of the button label
Button Background Button color 0...100
Button Label Color Color used for the button label –
Button Label Font Font used for the button label
Border Width Width (in pixels) of the graphic object border 0...32
Border Color Color of the graphic object border –

Property Description Limits

Property Description Limits
Name Name of the graphic object –
Address Direct address of the variable to monitor Note 1 (see page 109)
Data Type Variable data type Note 2 (see page 109)
Background Graphic object background color –
Label Label to be displayed as part of the graphic object
Label Color Color of the label
Label Font Font used for the label
Maximum EU Value Maximum value of the variable in physical units
Minimum EU Value Minimum value of the variable in physical units
Maximum Value Maximum gross value (without scale) of the device variable Note 3 (see page 109)
Minimum Value Minimum gross value (without scale) of the device variable Note 3 (see page 109)
Maximum Input Maximum value, expressed in physical units, authorized for 

the value entered in input
–

Minimum Input Minimum value, expressed in physical units, authorized for 
the value entered in input

Border Width Width (in pixels) of the graphic object border 0...32
Border Color Color of the graphic object border –
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Indicator Light
The indicator light provides a double indication of the value of a variable in a device. If the Input 
Inverted property is not set to TRUE, a zero input value is declared as being OFF and a non-zero 
value is declared as being ON. If the Flash Interval property is set to a positive value, the indicator 
light will flash when the input value is equal to ON.
This table describes the properties of the indicator light:

Property Description Limits
Name Name of the graphic object –

Address Direct address of the variable to monitor Note 1 
(see page 109)

Data Type Variable data type Note 2 
(see page 109)

Background Graphic object background color –
Label Label to be displayed as part of the graphic object

Label Color Color of the label

Label Font Font used for the label
Off Word Text to be displayed when the input value is OFF

Off Word 
Background

Background color of the indicator light when Off Word is displayed

Off Word Color Color of the Off Word text
Off Word Font Font used for the Off Word text

On Word Text to be displayed when the input value is ON

On Word 
Background

Background color of the indicator light when On Word is displayed

On Word Color Color of the On Word font
On Word Font Font used for the On Word text

Flash Interval The flashing time for the indicator light (expressed in milliseconds) 
when the input value is ON. Set to zero for no flashing.

200...2000

Shape Shape (circular, rectangular, etc.) of the indicator light –
Input Inverted On TRUE, inverts the input value. (The indicator displays Off Word 

when the input value is ON.)
Border Width Width (in pixels) of the graphic object border 0...32

Border Color Color of the border of the graphic object –

Value Simulated input value for testing the graphic object Note 3 
(see page 109)
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Motor Control Station
The motor control station is designed to imitate the on/off push button standard station which is 
frequently used to control the motors. This graphic object is essentially composed of 2 push 
buttons and an indicator light. To facilitate the configuration of this object’s many properties, a 
custom module is provided. It is by means of this module, and not the Graphic Editor properties 
sheet, that the properties (apart from the name) are configured.
This table describes the properties of the motor control station:

Analog Meter
An analog meter gives an analog representation of the value of a variable in a device. It is 
represented by a pointer on a circular dial whose position corresponds to a percentage of its range 
in physical units. You can set the size of the meter’s circular dial (circle degrees sweep), its colors 
and the style of the pointer.
This table describes the properties of the analog meter:

Property Description Limits

Name Name of the graphic object –
Background Graphic object background color 

Label Label to be displayed as part of the graphic object

Label Color Color of the label
Label Font Font used for the label

Border Width Width (in pixels) of the graphic object border 0...32

Border Color Color of the graphic object border –
Indicator Light Properties identical to those of the Indicator Light graphic object 

with the exception of the shared properties listed above
Top Push Button Properties identical to those of the Push Button graphic object with 

the exception of the shared properties listed above

Bottom Push Button Properties identical to those of the Push Button graphic object with 
the exception of the shared properties listed above

Property Description Limits
Name Name of the graphic object –

Address Direct address of the variable to monitor Note 1 
(see page 109)

Data Type Variable data type Note 2 
(see page 109)
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Background Graphic object background color –

Label Label to be displayed as part of the graphic object
Label Color Color of the label

Label Font Font used for the label

Major Scale Divisions Number of major scale divisions (marked) 0...100
Minor Scale Divisions Number of minor scale divisions (not marked) 0...100

Scale Color Color of the scale and its labels –

Scale Font Font used for the scale labels
Scale Precision Number of decimal places to be shown for the scale labels 

(set to -1 to use a general exponential format)
-1...6

Maximum EU Value Maximum value of the variable in physical units –

Minimum EU Value Minimum value of the variable in physical units
Maximum Value Maximum gross value (without scale) of the device variable Note 3 

(see page 109)
Minimum Value Minimum gross value (without scale) of the device variable Note 3 

(see page 109)
Dial Degrees Sweep Portion of circular segment to be used to draw the dial 60...300

Pointer Type Type of pointer used (needle, arrow, etc.) –
Pointer Color Color used for the pointer

Dial Color Color used for the dial (for the part in the High/Low range)

High High Limit Value Value of the "High High" limit expressed in physical units
High High Limit Color Color of the indicator bar if the scale value is greater than the 

"High High" limit
High Limit Value Value of the "High" limit expressed in physical units

High Limit Color Color of the indicator bar if the scale value is greater than the 
"High" limit.

Low Limit Value Value of the "Low" limit expressed in physical units

Low Limit Color Color of the indicator bar if the scale value is less than the 
"Low" limit

Low Low Limit Value Value of the "Low Low" limit expressed in physical units

Low Low Limit Color Color of the indicator bar if the scale value is less than the 
"Low Low" limit

Border Width Width (in pixels) of the graphic object border 0...32

Border Color Color of the graphic object border –
Value Simulated gross starting value (without scale) for testing the 

graphic object
Note 3 
(see page 109)

Property Description Limits
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Rotary Slider
A rotary slider gives an analog representation of the value of a variable in a device. It is represented 
by a knob on a circular dial whose position corresponds to a percentage of its range in physical 
units. You can set the size of the dial and the color of the knob. Using the mouse, you can change 
the position of the knob by sending a new value to the device.
This table describes the properties of the rotary slider:

Property Description Limits
Name Name of the graphic object –

Address Direct address of the variable to monitor Note 1 
(see page 109)

Data Type Variable data type Note 2 
(see page 109)

Background Graphic object background color –
Label Label to be displayed as part of the graphic object

Label Color Color of the label

Label Font Font used for the label
Major Scale Divisions Number of major scale divisions (marked) 0...100

Minor Scale Divisions Number of minor scale divisions (not marked) 0...100
Scale Color Color of the scale and its labels –

Scale Font Font used for the scale labels

Scale Precision Number of decimal places to be shown for the scale labels (set 
to -1 to use a general exponential format)

-1...6

Dial Degrees Sweep Portion of circular segment to be used to draw the dial 60...300
Dial Color Color of the dial –

Knob Color Color used for the knob

Maximum EU Value Maximum value of the variable in physical units
Minimum EU Value Minimum value of the variable in physical units

Maximum Value Maximum gross value (without scale) of the device variable Note 3 
(see page 109)

Minimum Value Minimum gross value (without scale) of the device variable Note 3 
(see page 109)

Border Width Width (in pixels) of the graphic object border 0...32
Border Color Color of the graphic object border –
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Rotary Selector
A rotary selector allows you to choose from a number of options. Once the selection has been 
made, the value corresponding to the choice is sent to the device. The choices are represented by 
the marks on a "scale", the current selection being indicated by the position of the knob. The size 
of the circular dial (circle degrees sweep) and the color of the knob can be configured.
This table describes the properties of the rotary selector:

Trend Recorder
A trend recorder enables you to obtain a continuous, time-based graphic of the values of a 
maximum of six variables in a device. It emulates a strip-chart recorder, with the pens on the right 
and the "paper" moving from right to left. A vertical scale to the left of the graphic indicates the 
range of registered values and a horizontal scale beneath the graphic displays the range’s time 
frame. You can set the update frequency and the appearance of the graphic.
To facilitate the configuration of the many properties of this object, a custom module is provided. It 
is by means of this module, and not the Graphic Editor properties sheet, that the properties (apart 
from the name) are set.

Property Description Limits
Name Name of the graphic object –

Address Direct address of the variable to monitor Note 1 
(see page 109)

Data Type Variable data type Note 2 
(see page 109)

Background Graphic object background color –
Choices Selector choices Each choice is indicated in the form of a 

"label=value" input (when you select a "label", the "value" is sent 
to the device).

At least two 
choices required

Label Label to be displayed as part of the graphic object –
Label Color Color of the label

Label Font Font used for the label
Scale Visible Indicates if a "scale", labeled with the choices should be 

displayed
Scale Color Color of the scale and its labels

Scale Font Font used for the scale labels

Dial Degrees Sweep Portion of circular segment to be used to draw the dial 60...300
Knob Color Color used for the knob –

Border Width Width (in pixels) of the graphic object border 0...32

Border Color Color of the graphic object border –
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This table describes the properties of the trend recorder. (The properties available for each of the 
pens are described in the next table):

These are the available trend recorder properties for each pen:

Property Description Limits
Name Name of the graphic object –

Background Graphic object background color 

Label Label to be displayed as part of the graphic object
Label Color Color of the label

Label Font Font used for the label

Major Scale Divisions Number of major scale divisions (marked) 0...100
Minor Scale Divisions Number of minor scale divisions (not marked) 0...100

Scale Color Color of the scale and its labels –
Scale Font Font used for the scale labels

Scale Precision Number of decimal places to be shown for the scale labels 
(set to -1 to use a general exponential format)

-1...6

Maximum EU Value Maximum value of the variable in physical units –

Minimum EU Value Minimum value of the variable in physical units
Update Period Graphic update interval (in seconds) 0.5...120

Time Scale Divisions Number of divisions on the horizontal scale 0...6

Chart Background Color of the graphic zone –
Grid Color Color of the grid drawn in the graphic zone

Vertical Grid Divisions Number of vertical divisions in the grid 0...100
Border Width Width (in pixels) of the graphic object border 0...32

Border Color Color of the graphic object border –

Property Description Limits

Address Direct address of the variable to monitor Note 1 (see page 109)
Data Type Variable data type Note 2 (see page 109)
Maximum Value Maximum gross value (without scale) of the device variable Note 3 (see page 109)
Minimum Value Minimum gross value (without scale) of the device variable Note 3 (see page 109)
Pen Color Color of the "pen" which allows the value placed on the scale 

to be recorded
–

Pen Label Label used to identify the pen
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Display Link
A display link is a special graphic object which allows you to move to another graphic display by 
clicking it. To indicate that the object represents a link towards another display, the link’s text label 
is underlined and the mouse cursor changes to a hand when it passes over it. This object is 
especially useful when the Graphic Editor is used in View mode which has no drop-down list of 
graphic displays.
A display link can also be used as an hypertext link to an HTML file. If you enter a URL such as 
Link Display Name, you can open it in a new browser window by pressing the SHIFT key while 
clicking the link. If you only click the link, the existing browser window is replaced by the URL.
If the Link Display Name is blank, the label is not displayed underlined and the object displayed 
becomes a simple text label.
This table describes the properties of the display link:

Datalogging History
A Datalogging History provides a continuous, time-based charting of the value of up to six symbols 
(variables) coming from the log file of the Datalogging service. A Datalogging History emulates a 
strip-chart recorder, with the pens on the right, and the "paper" moving from right to left. A vertical 
scale can be shown on the left side of the chart for showing the range of the values being recorded, 
and a horizontal scale can be shown below the chart for showing the time span of the chart.
NOTE: In order to plot the Datalogging History, select the Timestamp option in the Datalogging 
Service (see Web Designer, TSX ETG 3000 Product Range, User Manual) configuration window.
In order to make it easier to set this object’s many properties, a Customizer is provided. Use the 
Customizer (and not the Graphic Editor’s Property Sheet) to set Datalogging History properties 
(except Name).
3 buttons are available in edition and animation mode:

Reload: the Datalogging History object is a static widget. This button enables to refresh the 
value used to build the chart.
+: zoom on the trend. It decreases the time scale in order to have a better vision of a part of the 
trend.
-: zoom out on the trend. It increases the time scale in order to have a larger vision of the trend.

If you place the mouse cursor on a point of the trend, a tooltip appears displaying the exact value 
at that point. Stay pressed and rollover several points to display their tooltips.

Property Description

Label Label of the link
Link Display Name Name of the graphic display to load when the user clicks on the link, or URL of a web 

page
Label Color Color of the label

Label Font Font used for the label
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Releasing the mouse button and rolling over any point will cleanup existing tooltips and display a 
new one.
Right click on it to make it disappear.
This table describes properties for the Datalogging History. (Properties available for each pen are 
described in the next table.)

Property Description Limits

Name The name for the graphic object –

Background The background color for the graphic object
Label The label to be displayed as part of the graphic object

Label Color The color for the label
Label Font The font for the label

Major Scale Divisions The number of major (labeled) scale divisions 0...100

Minor Scale Divisions The number of minor (unlabeled) scale divisions 0...100
Scale Color The color for the scale and its labels –

Scale Font The font for scale labels

Scale Precision The number of fractional digits to be shown for scale labels (Set 
to -1 to use a general exponential format.)

-1...6

Maximum EU Value The maximum value, in engineering units, of the symbol 
(variable)

–

Minimum EU Value The minimum value, in engineering units, of the symbol 
(variable)

Update Period The update interval (in seconds) for the chart 0.5...120

Time Scale Divisions The number of horizontal scale divisions 0...6

Chart Background The color for the chart area –
Grid Color The color of the grid drawn in the chart area

Vertical Grid 
Divisions

The number of vertical divisions for the grid 0...100

Border Width The width (in pixels) for the graphic object’s border 0...32

Border Color The color for the graphic object’s border –
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These Datalogging History properties are available for each pen:

Notes on this Topic
The above tables refer to these notes:

Property Description Limits

Name of the CSV 
file

The name of the CSV file used to build the trend.
Location: 

Default (no path): the file is located on the FLASH memory.
/CFA00/USERDATA/TABLEx: the file is located on the CF 
card.
/USBHD/00/USERDATA/TABLEx: the file is located on the 
USB memory.
/RAMDISK/USERDATA/TABLEx: the file is located on the 
saved RAM.

Note: the log file includes timestamps (see Web Designer, TSX 
ETG 3000 Product Range, User Manual).

–

Address The name of a symbol (variable) to monitor.

Data Type The data type of the symbol (variable).
Note: the data type is numerical.

Maximum PLC 
Value

The maximum raw (unscaled) value of the symbol (variable) in the 
PLC.

Note 3 
(see page 109)

Minimum PLC 
Value

The minimum raw (unscaled) value of the symbol (variable) in the 
PLC.

Note 3 
(see page 109)

Pen Color The color of the "pen" used to record the scaled value. –
Pen Label The label used to identify the pen.

Note 1 A direct Modbus address is a number between 0 and 65535.
Note 2 The various values of the Data Type property for a direct Modbus address have these 

meanings:
COIL output bit (Boolean)
DISCRETE INPUT input bit (Boolean)
REGISTER 16-bit signed integer
INT32 32-bit signed integer
INT32SWAP 32-bit signed integer with least significant and most significant 

words inverted
INPUT REGISTER 16-bit signed integer for analog input

Note 3 The limits of the Maximum PLC Value and Minimum PLC Value properties are the natural 
limits of the configured Data Type property.

Note 4 For a push button, specify at least one value. If several values are entered, they are assigned 
to an address table starting with the direct address indicated.
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Extended Graphic Objects

Introduction
The extended graphic objects available in the Graphic Editor are designed to help you to create 
graphic displays imitating advanced graphic display panels. The data control and monitoring 
objects have integrated communication functions and are designed as standalone graphic objects.
Be aware, however, that if communication to the device linked to the graphic object is lost, the 
object becomes inoperative without the end device's knowledge.

For example, say you have programmed a pushbutton object to jog a motor when the button is 
depressed and to stop jogging when the button is released. If communications are lost while the 
button is depressed, the motor will continue to jog even when the button is released. Graphic 
objects should not be used to control situations such as this unless other interlock methods are 
installed in the system.
In addition, to help clients who wish to insert several simple applets into a single HTML page, 
objects in the Graphic Editor exist in the form of applets. When combined with the LiveBeanApplet, 
the graphic objects in the Graphic Editor can be used in the same way as the LiveLabelApplet.

ASCII Text Editor
The ASCII text editor is based on the message display graphic element. It enables new text to be 
entered.
The properties of the ASCII text editor are as follows:

WARNING
UNINTENDED EQUIPMENT OPERATION
Do not use graphic objects in situations where loss of communication to the module can put 
human integrity or material damage at risk.
Failure to follow these instructions can result in death, serious injury, or equipment damage.

Property Description Limits

Name Name of the graphic object –
Address Direct address of the variable to monitor Note 1 (see page 119)
Max. Text Length Maximum length of the text –

Text Color Color of the text
Text Font Font of the text

Swap Bytes False if the target byte order is the same as that of the PC
Value The text itself
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Bar Graph
A bar graph gives an analog representation of the value of a variable in a device. It draws a vertical 
bar whose length is proportional to the value and represents a percentage of its range in physical 
units.
The properties of the bar graph are as follows:

Property Description Limits
Name Name of the graphic object –
Address Direct address of the variable to monitor Note 1 (see page 119)
Data Type Variable data type Note 2 (see page 119)
Background Graphic object background color –
Label Label to be displayed as part of the graphic object
Label Color Color of the label
Label Font Font used for the label
Maximum EU Value Maximum value of the variable in physical units
Minimum EU Value Minimum value of the variable in physical units
Maximum Value Maximum gross value (without scale) of the device 

variable
Note 3 (see page 119)

Minimum Value Minimum gross value (without scale) of the variable in the 
device

Note 3 (see page 119)

Bar Background Background color of the indicator bar –
Bar Color Color of the indicator bar (if the scale value is within the 

High/Low range)
High High Limit Value Value of the "High High" limit expressed in physical units
High High Limit Color Color of the indicator bar if the scale value is greater than 

the "High High" limit
High Limit Value Value of the "High" limit expressed in physical units
High Limit Color Color of the indicator bar if the scale value is greater than 

the "High" limit.
Low Limit Value Value of the "Low" limit expressed in physical units
Low Limit Color Color of the indicator bar if the scale value is less than the 

"Low" limit
Low Low Limit Value Value of the "Low Low" limit expressed in physical units
Low Low Limit Color Color of the indicator bar if the scale value is less than the 

"Low Low" limit
Limit Deadband Neutral range (as a percentage of the EU range) to apply 

to verification of the High/Low limit
0...10

Border Width Width (in pixels) of the graphic object border 0...32
Border Color Color of the graphic object border –
Value Simulated gross input value (without scale) for testing the 

graphic object
Note 3 (see page 119)
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Bitmap
The bitmap interface graphic element displays a static bitmap on the screen.
The properties of the bitmap interface graphic element are as follows:

Adding Images
You can add images into the module in one of the following way:

Add your images into the images.zip file (path: /NAND/FLASH1/wwwroot).
Create a directory into the module (i.e. /NAND/FLASH1/wwwroot/bitmaps). Copy your images 
into this directory. In this case, you need to specify the path of the images you want to use (i.e. 
/NAND/FLASH1/wwwroot/bitmaps/key.gif).

Property Description Limits
Name Name of the graphic object –

Background Graphic object background color Note 1 (see page 119)
Label Label to be displayed as part of the graphic object –
Label Color Color of the label

Label Font Font used for the label
Border Width Width (in pixels) of the graphic object border

Border Color Color of the graphic object border

Bitmap Choices File names of custom bitmaps to display
Refer to the next paragrah for information on adding images 
into the module.

Step Action
1 Create an images folder on your PC.

2 Copy the images you want to use in this folder.

3 Import the user.jar file from the TSX ETG 30•• to the PC (path: 
/NAND/FLASH1/wwwroot/classes) using a FTP client.

4 Open the user.jar file using a file archiver.

5 Drag and drop the images folder in the user.jar file. Confirm that the relative path of the image 
files is ‘images/’.

6 Transfer the user.jar file back to the module using a FTP client.
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Generic Bitmap
The generic Bitmap interface graphic element can display a static bitmap for each separate value 
of a variable. It can be used to display dynamic animations, such as the variation in level of a 
reservoir.
The properties of the generic Bitmap interface graphic element are as follows:

Graphic Link
A graphic link is a special graphic object that moves to another graphic display when you click it 
with the mouse. Graphic links can also be recognized by their underlined labels, and by the fact 
that the mouse cursor changes to a hand when it passes over them. They are especially useful 
when the Graphic Editor is used in Display mode, in which there is no pull-down list of graphic 
displays.
A graphic link can also be used as a hypertext link to an HTML file. If you enter a URL such as Link 
Display Name, you can open the URL in a new browser window by pressing the SHIFT key while 
clicking on the link. If you only click the link, the URL will open in the existing browser window.
If the Link Display Name is not filled in, the label will not be underlined and the object displayed 
becomes a simple text label.
The properties of the graphic link are as follows:

Property Description Limits
Name Name of the graphic object –
Address Direct address of the variable to monitor Note 1 (see page 119)
Data Type Variable data type Note 2 (see page 119)
Background Graphic object background color Note 1 (see page 119)
Label Label to be displayed as part of the graphic object –
Label Color Color of the label
Label Font Font used for the label
Bitmap Choices File names of custom bitmaps to display

Refer to the previous paragrah for information on adding 
images into the module.

Border Width Width (in pixels) of the graphic object border
Border Color Color of the graphic object border
Value Simulated starting value for testing the behavior of the 

graphic object

Property Description
Label Label of the link
Link Display Name Name of the graphic display to load when the user clicks on the link, or URL of a Web 

page
Label Color Color of the label
Label Font Font used for the label
Bitmap Choices Name of the bitmap file to be clicked on
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Indicator Light
The indicator light displays the value of a variable in a device. The input value of 0 is equal to OFF, 
and any value other than 0 is equal to ON. If the Flash Interval property is set to a positive value, 
the indicator light will flash when the input value is equal to ON. There is one bitmap for the ON 
state and another for the OFF state.
The properties of the indicator light are as follows:

Property Description Limits
Name Name of the graphic object –

Address Direct address of the variable to monitor Note 3 
(see page 119)

Data Type Variable data type Note 2 
(see page 119)

Background Graphic object background color –
Label Label to be displayed as part of the graphic object

Label Color Color of the label

Label Font Font used for the label
OFF Word Text to be displayed when the input value is OFF

OFF Bitmap Choice Indicator bitmap when the OFF word is displayed
OFF Word Color Color of the OFF word text

OFF Word Font Font of the OFF word text

ON Word Text to be displayed when the input value is ON
ON Bitmap Choice Indicator bitmap when the ON word is displayed

ON Word Color Color of the ON word font

ON Word Font Font of the ON word text
Flash Interval The flashing time for the indicator light (expressed in 

milliseconds) when the input value is ON. Set to 0 for no flashing.
200...2,000

Input Inverted On TRUE, inverts the input value. (The indicator displays the 
OFF word when the input value is ON.)

–

Border Width Width (in pixels) of the graphic object border 0...32

Border Color Color of the graphic object border –
Value Simulated input value for testing the graphic object Note 3 

(see page 119)
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Motor
The Motor graphic interface element displays the value of a variable in a device. The input value 
of 0 is equal to OFF, the value 1 is equal to ON and other values are equal to DEFAULT. These 
three states are represented by different bitmaps.
The properties of the Motor graphic interface element are as follows:

Property Description Limits

Name Name of the graphic object –
Address Direct address of the variable to monitor Note 1 (see page 119)
Data Type Variable data type Note 2 (see page 119)
Background Graphic object background color –

Label Label to be displayed as part of the graphic object

Label Color Color of the label
Label Font Font used for the label

OFF Word Text to be displayed when the input value is OFF

OFF Bitmap Choice Motor bitmap when the OFF word is displayed
OFF Word Color Color of the OFF word text

OFF Word Font Font of the OFF word text

ON Word Text to be displayed when the input value is ON
ON Bitmap Choice Motor bitmap when the ON word is displayed

ON Word Color Color of the ON word font
ON Word Font Font of the ON word text

DEFAULT Word Text to be displayed when the input value is ON

DEFAULT Bitmap Choice Motor bitmap when the DEFAULT word is displayed
DEFAULT Word Color Color of the DEFAULT word font

DEFAULT Word Font Font of the DEFAULT word text

Border Width Width (in pixels) of the graphic object border 0...32
Border Color Color of the graphic object border –

Value Simulated input value for testing the graphic object Note 3 (see page 119)
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Pipe
A pipe displays the value of a variable in a device that has two possible states. The input value of 
0 is equal to OFF, and any value other than 0 is equal to ON. There is one bitmap for the ON state 
and another for the OFF state.
The properties of the pipe are as follows:

Property Description Limits

Name Name of the graphic object –
Address Direct address of the variable to monitor Note 1 (see page 119)
Data Type Variable data type Note 2 (see page 119)
Background Graphic object background color –

Label Label to be displayed as part of the graphic object

Label Color Color of the label
Label Font Font used for the label

OFF Word Text to be displayed when the input value is OFF

OFF Bitmap Choice Pipe bitmap when the OFF word is displayed
OFF Word Color Color of the OFF word text

OFF Word Font Font of the OFF word text

ON Word Text to be displayed when the input value is ON
ON Bitmap Choice Pipe bitmap when the ON word is displayed

ON Word Color Color of the ON word font
ON Word Font Font of the ON word text

Border Width Width (in pixels) of the graphic object border 0...32

Border Color Color of the graphic object border –
Value Simulated input value for testing the graphic object Note 3 (see page 119)
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Push button
When activated with the mouse, a push button allows the user to send one or more preset values 
to a device.
The properties of the push button are as follows:

Property Description Limits

Name Name of the graphic object –

Address Direct address of the variable to monitor Note 3 (see page 119)
Data Type Variable data type Note 2 (see page 119)
Background Graphic object background color –
Values Values to send to the device Note 4 (see page 119)
Reset Values Values to send to the device once the reset delay has 

expired. If no reset value is given, the reset will not take 
place.

–

Reset Delay Delay (in milliseconds) that the push button waits between 
sending the values to the device and sending the reset 
values.

0...2000

Label Label to be displayed as part of the graphic object –
Label Color Color of the label

Label Font Font used for the label
Button Label Button label text

Button Label Color Color used for the button label

Button Label Font Font used for the button label
OFF Bitmap Choice Button bitmap when the OFF state is displayed

ON Bitmap Choice Button bitmap when the ON state is displayed

Border Width Width (in pixels) of the graphic object border 0...32
Border Color Color of the graphic object border –
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Distributor
A distributor displays the value of a variable in a device that has two possible states. The input 
value of 0 is equal to OFF, and any value other than 0 is equal to ON. There is one bitmap for the 
ON state and another for the OFF state.
The properties of the distributor are as follows:

Property Description Limits

Name Name of the graphic object –
Address Direct address of the variable to monitor Note 1 (see page 119)
Data Type Variable data type Note 2 (see page 119)
Background Graphic object background color –

Label Label to be displayed as part of the graphic object

Label Color Color of the label
Label Font Font used for the label

OFF Word Text to be displayed when the input value is OFF

OFF Bitmap Choice Distributor bitmap when the OFF word is displayed
OFF Word Color Color of the OFF word text

OFF Word Font Font of the OFF word text

ON Word Text to be displayed when the input value is ON
ON Bitmap Choice Distributor bitmap when the ON word is displayed

ON Word Color Color of the ON word font
ON Word Font Font of the ON word text

Flash Interval The flashing time for the indicator light (expressed in 
milliseconds) when the input value is ON. Set to 0 for no 
flashing.

200...2,000

Border Width Width (in pixels) of the graphic object border 0...32

Border Color Color of the graphic object border –

Value Simulated input value for testing the graphic object Note 3 (see page 119)
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Notes
The notes relating to this section are as follows:

1. The Data Type property needs to correspond exactly to the actual data type of the variable.
If the Address property is the direct address of a binary PLC reference (reference 0x/1x Quantum for 
example), set the Data Type property to Coil for outputs or to Discrete Input for discrete inputs.

2. The various values of the Data Type property have the following meanings:

Type Signification
COIL output bit (Boolean)

DISCRETE INPUT input bit (Boolean)
REGISTER 16-bit signed integer

INT32 32-bit signed integer

INT32SWAP 32-bit signed integer with least significant and most significant words inverted
INPUT REGISTER 16-bit signed integer for analog input

3. The limits of the Maximum PLC Value and Minimum PLC Value properties are the natural limits of the 
configured Data Type property.

4. For a push button, specify at least one value. If several values are entered, they will be assigned to an 
address table starting with the direct address indicated.

5. For the applet to display a numerical data value instead of a label, specify parameters in the HTML 
code as follows: name = "label" value = "$data$".
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Section 7.3
Adding Microsoft Silverlight® Pages

Adding Microsoft Silverlight® Pages

Introduction
Use the commands in Web Designer to create new—or import existing—Microsoft Expression 
Blend applications, and add them to your Web Designer project. Expression Blend is a powerful 
development platform you can use to create graphically rich Silverlight pages for your website.
When you launch Expression Blend from Web Designer, the following tools are available for use 
in Expression Blend:

a collection of custom FactoryCast objects—developed by Schneider Electric—that you can 
embed in your Silverlight pages
a list of PLC variables—imported from your Unity Pro project—that you can use to animate the 
Factory Cast objects you add to your Silverlight pages

Expression Blend Commands
With a Web Designer project open, you can use the following commands to add an Expression 
Blend application to your website.
To create a new Expression Blend application:
<Project> → <Target> → GraphicScreens → New Microsoft Blend Application
To import an existing Expression Blend application:
<Project> → <Target> → GraphicScreens → Import Blend Application

Further Reference
For instructions on how to use Expression Blend and the Schneider Electric Factory Cast custom 
objects, refer to the following documents:

Expression Blend help
Web Designer Objects Library for Microsoft Expression Blend®, which you can access as 
follows:

as a help file, from the Web Designer software Help menu, or 
in .pdf format from the Web Designer installation disk
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Section 7.4
PLC Program Viewer

PLC Program Viewer

Presentation
The PLC program viewer feature enables you to visualize and monitor UnityPro programs in run 
mode using a Web Designer. The PLC programs are displayed and animated as they are in 
UnityPro
PLC programs developed in any languages supported by UnityPro can be visualized:

Ladder (LD)
Instruction List (IL)
Function Block Diagram (FBD)
984 Ladder Logic (LL984)
Structured Text (ST)
Sequential Function Chart (SFC)

Accessing the PLC Program Viewer

Step Action
1 Double click the PLC (Devices directory) you want to monitor in the Web Designer navigator.

2 Click the PLC Programs tab.
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Importing PLC Programs
The following procedure shows you how to import PLC programs from UnityPro to Web Designer.

Step Action
1 In the Web Designer Navigator window, under <Target> → Devices, double click on the PLC device 

to which you will import a program. The Device window opens.
2 In the Device window, click on the PLC Programs tab to open that window (below):

3 Click Import on the right side of the PLC Programs window.
Result: the Open window appears.

4 Use an external tool (such as 7-Zip) to extract the .XEF file from the .ZEF file exported from 
Unity Pro.
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5 Select the Unity Pro file (.XEF) containing PLC Programs data.
Click Open.
Result: the Import PLC Programs window appears.

6 Select the sections of the PLC program you want to monitor using the checkbox.
Click Browse to select the STU or .XVM file associated to the .XEF for variables animation.
Note: It is advised to import from .XVM for the import to be faster. As some elements are not 
available in the .XVM, a STU could be required to complete the import.

Click Import.
Result: the sections of the PLC program selected appear in the navigation tree of the PLC Program 
tab.

Step Action
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Accessing an Animated PLC Program

Representation and Color Convention
The PLC Program Viewer window:

1 Navigation tree: select the section of the PLC program you want to visualize
2 Display window: this zone displays the animated PLC program
3 Console: displays selected trace event data 

Step Action

1 Select a target in a project.
2 Click Target → Connect → Simulation (Alt + S) to switch to simulation mode or,

click Target → Connect → Target (Alt + C) to switch to run mode.

3 Extend the target directory.
4 Select a device in the Devices directory.

5 Right-click and select Open.
Result: an Internet Explorer window in which the PLC program viewer window associated with 
the selected device appears.

5 Select the PLC program section you want to visualize in the navigation tree.
Result: the PLC program appears in the Display window.
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Variables animation:
Boolean are displayed in:

green if its value is true
red if its value is false

Other types display the name or the value of the variable in yellow. Use the tool tip to see more 
information as the name of the variable, its type, its address and its comment.

Links animation:
Links connected to boolean variables are displayed in green or red depending on the value of 
the variable they are connected to (green if true red if false).
Other links are displayed in black.

SFC animation:

The colors used for the different elements are: 
for steps: 

green if the step is active,
white if the step is inactive,
yellow if the activity time of the step is less than the minimum programmed time,
pink if the activity time of the step is greater than the minimum programmed time.

for macro-steps:
when a macro-step becomes active the upper half is shown in green,
when the OUT step of the macro-step is active the whole of the macro-step is shown in green,
when the macro-step becomes inactive it is then shown in white.

for transitions associated with a Boolean element or a simple Boolean expression:
green if the element or the expression is TRUE,
red if the element or the expression is FALSE.

for transitions associated with a section:
black as long as the previous step remains inactive,
green if the conditions in the section are TRUE, 
red if the conditions in the section are FALSE.
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LL984 animation:

The colors used for the different variables, and their meanings, are: 
Black: not monitored
Yellow: real time value isn’t available
Red: a boolean set to false
Green: a boolean set to true
Black with yellow background: a non-boolean (for example, a constant)

Tool Tip
The tool tip function is a help bubble which is displayed when you move the cursor over a variable. 
It displays information about the value of the variable only if its name is visible in the viewer.
Click on the variable to display the bubble permanently. Right click on it to make it disappear.

Zoom In / Out
The PLC program viewer presents two buttons you can use to zoom in and zoom out of the 
program display. These buttons are located at the top right corner of the PLC program viewer:

Click on the button on the left (with the “+” sign) to zoom in up to three magnification levels.
Click on the button on the right (with the “–” sign) up to three times to zoom out and display the 
entire program in the PLC program viewer. 
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Show / Hide Console and Navigation Tree
The PLC program viewer presents two buttons you can toggle to show or hide the the PLC program 
viewer’s console and navigation tree. These buttons are located at the top left corner of the PLC 
program viewer:

Toggle the button on the left to show or hide the console. 
Toggle the button on the right to show or hide the navigation tree.

Limitations
Only PLC programs created using UnityPro 4.0 or later can be viewed.
You can only monitor PLC programs, changes are not allowed.
The following objects are not animated, they appear in black:

Objects for which the result depends on an expression
Function blocks without instance for which there is no information on input/output variables
Standard DFB (i.e. ALARM_DIA)
Multiple dimension tables
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Chapter 8
Setting Up an External Tool

Setting Up an External Tool

Overview
You can use Web Designer in concert with a standard external tool to edit files for your website.
The examples in this chapter show you how to set up FrontPage to open website files. The 
procedure, however, applies to other software packages, like Microsoft Expression Blend.
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Example
Set up an external tool:

Step Action
1 Open the External Tools setup window (Options → Configuration of an external tool → External 

tools):
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2 Click New to proceed to the next screen:

3 Enter a name for the external software (in this case, FrontPage).

4 In the Location area, click Browse File System to open a file explorer window.
5 Select the path of the .exe file of the external software (for example, 

C:\windows\frontpage\frontpage.exe).
6 In the Working Directory area, click Browse File System to open a file explorer window.

7 Specify the directory that contains the files you want to open with your external tool (for example, 
C:\workspace\WD_project\website.

Step Action
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8 In the Arguments area, click Variables... to open the Select Variables window:

9 Select the ressource_loc variable that returns the absolute file system path of a resource.

10 Click Apply.
11 Click Close.

12 Select a file of the website in your Web Designer navigator.

13 Open the selected file by opening FrontPage (Options → Configuration of an external tool → 
FrontPage).

Step Action
132 35016149 10/2017



Web Designer for FactoryCast
Workspace
35016149 10/2017
Changing the Workspace Directory

Chapter 9
Changing the Workspace Directory

Presentation
The workspace is the space where projects are stored. Only those located in the current 
workspace can be opened. Projects are automatically created in the current workspace. It is 
possible to have several workspaces and to pass from one to another.
This function enables you to change the path to the workspace.
To do this, select Change Workspace... in the Options menu.
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Chapter 10
Formatting and Restarting a Module

Re-start/Format a Module

Introduction
Re-starting is necessary to take into account the modifications made to the application.
Formatting deletes the website on the module and restores the default website (Website, gdt and 
rdt directories). Formatting allows you to delete the modifications made to the website of a module, 
in order to start a fresh one from a defined status. It does not modify the system configuration.
NOTE: This topic does not apply to the Modicon M580 platform.

Re-start the Module
The following table shows how to re-start a module:

Format the Module
The following table shows how to format a module:

Step Action
1 In the menu tree, select a module.

2 In the Target menu, click Reboot target. 

Step Action

1 In the menu tree, select a module.

2 In the Target menu, click Format target. 
Result: the Configuration Password window appears if a configuration password has already 
been set. Otherwise the formatting starts.

3 Enter the configuration password and click OK.
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Chapter 11
Security

Subject of this Chapter
This chapter explains how to manage the security for a website using a firewall, access rights and 
password protection. 

What Is in This Chapter?
This chapter contains the following topics:

Topic Page

Internal Security 138
External Security 139

Variable Access Security, Symbol, Direct Address 141

Changing Passwords 142
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Internal Security

Overview
Web Designer provides 2 mechanisms to allow that only authorized users view and modify your 
data:

password entry,
write restrictions.

Anyone who has access to a configuration tool and to your embedded server can override your 
security settings and download new settings to the server. Unauthorized or incorrect changes to 
data may change the behavior of your application in ways that may be undesirable or hazardous.

Password Entry
Although you may add unprotected Web pages to the site, the default Web pages and any other 
pages to which you want to restrict access can only be viewed by users who supply the correct 
user name and password.

Restrictions 
Restrictions are applied overall.
When you create a website and you want to restrict access to it, place it in the folder called secure.

WARNING
UNINTENDED OPERATION
Restrict control of access to the embedded server:

Change passwords monthly.
Do not use simple user names and passwords.
Disable default passwords before commissioning the module.

Failure to follow these instructions can result in death, serious injury, or equipment damage.
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External Security

Overview
If your network has been configured to enable users to consult your Internet site, your security 
system is the same as that of an intranet site, only you have an additional security measure: a 
firewall.

Architecture of a Firewall
A firewall forms a gateway between Internet and your embedded server. You can use a firewall to 
restrict or forbid access to your website.
A firewall can be configured to authorize network connections to a limited range of ports, or to 
authorize traffic to or from certain IP addresses. 

Types of Firewalls
There are two types of firewalls:

Network firewalls
Application firewalls

Network Firewalls
Network firewalls are often installed between the Internet and a single entry point to an intranet or 
internal network.
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Application-Level Firewalls
An application firewall works for an application, for example FTP. It intercepts all traffic sent to this 
application, and decides whether or not to transmit this traffic to the application. Application 
firewalls are located on individual host computers.

Firewall Configuration
Web Designer uses HTTP, FTP and Schneider Electric Modbus application protocol (MBAP) to 
access embedded server pages and files. If you want viewers to be able to access your site from 
the Internet and your embedded server is behind by a firewall, you need to configure the firewall 
to authorize HTTP, FTP and MBAP traffic.

NOTE:  
The default FTP name and password are USER/USER.
The FactoryCast client follows the "Firewall Friendly FTP" standard, RFC 1579. It issues an FTP 
PASV command to the FactoryCast server before any attempt to establish an FTP data 
connection.
The online mode of the configuration tool is not operational if the module is behind a firewall. 
The ports in this mode are dynamically assigned.

Port Protocol Access to...

21 FTP Embedded server files (behind a firewall)
Higher than 1024

80 HTTP Web pages

502 MBAP Operational data
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Variable Access Security, Symbol, Direct Address

Presentation
Users who enter the write password can only modify variables (symbols) and direct addresses 
which are write-enabled. When you create a WEB-enabled database of variables and direct 
addresses, you can designate each element as read-only or write-enabled.
Unauthorized or incorrect modifications made to symbols and direct addresses may have 
undesirable or hazardous effects on the behavior of your application.

WARNING
UNINTENDED EQUIPMENT OPERATION

Restrict access to the embedded server by configuring passwords.
Carefully select the symbols and direct addresses you authorize to be modified online.
Do not authorize online modification of variables of critical nature concerning human and 
material integrity.

Failure to follow these instructions can result in death, serious injury, or equipment damage.
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Changing Passwords

Introduction
This page enables you to modify the different user names and passwords that are used for 
identification.

Modify Passwords
This table describes how to change passwords:

Step Action

1 In the browser, select the target.
2 In the Target menu, click Properties.

Result: The target properties window appears.

3 Select Security.
Result: The following window appears. For security reasons, the FTP Password field is disabled.
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4 Click Modify to change a password. Refer to the next paragraph for a description of each 
password.
Result: The password window appears.

5 Enter a new password and confirm it by typing it in the Confirm new password field.
If it is an HTTP password, the login is also requested.

6 Click OK in the Password window. 
Note: if you leave any fields empty during the modification, you are asked to confirm the 
replacement of the current password with an empty password.

7 Repeat steps 4...6 for each password to modify.

8 Click OK in the Properties window of the target to close the window.

Step Action
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Function
This table describes the fields and lists whether a field is enabled or disabled for each 
communication module:

Field Description Module Restrictions

Secure HTTP 
Password

Required for connecting to the 
secure HTTP pages of the 
module website via a browser

Enabled TSX ETG 30••
TSX ETY 5103
140 NWM 100 00
TSX WMY 100

Disabled 140 NOE 771 11 
140 NOE 0110
BME NOC 0311
BME NOC 0321

Write Password Required to write variables in 
animation mode

Enabled TSX ETG 30••
TSX ETY 5103
140 NWM 100 00
TSX WMY 100
140 NOE 771 11 
140 NOE 0110

Disabled BME NOC 0311
BME NOC 0321

Configurator 
Password

Required to access the 
configuration parameters of the 
module

Enabled TSX ETG 30••
TSX ETY 5103
140 NWM 100 00
TSX WMY 100
140 NOE 771 11 
140 NOE 0110

Disabled BME NOC 0311
BME NOC 0321

FTP Password Enabled —

Disabled TSX ETG 30••
TSX ETY 5103
140 NWM 100 00
TSX WMY 100
140 NOE 771 11 
140 NOE 0110
BME NOC 0311
BME NOC 0321
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Appendix A
Menu

Subject of this Chapter
This chapter describes the menus for Web Designer functions. 

What Is in This Chapter?
This chapter contains the following topics:

Topic Page
Menu 148

Contextual Menu 150
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Menu

Overview
The following table shows the complete menu system when every function is supported:

Menu Sub-menu Overview

Project New Create a new project:
Creating a new module/device/data table/graphic page.
Creating a service.
Creating files and folders.

Open project Open an existing project.

Close project Close current project.
Save Save item modified in the project.

Save all Save every unsaved item modified in the project.

Import Importing an existing (.zip) project or converting a FactoryCast or 
FactoryCast HMI project.

Export Exporting the current project to a .zip file.
Global transfer Downloading the project's modules (and files).

Project Validation Verifying the project before transfer.

Refresh Updating the window and menu tree.
Properties View/modify the project’s properties (passwords, comments, etc.).

Quit Exit application
Edit Undo Cancel last action.

Cut Destruction of the selected object and putting it on the clipboard (the object 
can be a project, a module, a device, a graphic object, a file, a variable etc.).

Copy Copy the object to the clipboard.

Paste Paste the clipboard.
Delete Delete the selected object.

Find... Search for text in the project.
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Target Transfer Transfer files, either from your PC to the destination, or from the destination 
to your PC.

Partial Transfer Transfer only graphic pages, data tables and service directories, either from 
your PC to the destination, or from the destination to your PC.

Connect Connecting to the module (if the module authorizes the connection) or to the 
simulator.

Disconnect Disconnecting from the module or from the simulator

Stop all services Shutting down the services (for targets using services).
Start all services Starting the services (for targets using services).

Site Explorer Display a view of the website in the window on the bottom.
Reboot target Rebooting the connected module (for modules that authorize).

Format target Formatting the connected module (for modules that authorize).

Set target address Display/modify the IP Address, user name and password of the target.
Synchronize with 
PLC database

Synchronize the namespace of your project with a PLC database. Not 
available for FactoryCast targets.

Properties View/modify the target’s properties.

Service Stop Shut down current service.

Run Start current service.
Operator screens View operator screens.

Print Print current service.
Statistics View statistics for the selected service (incoming messages, outgoing 

messages, etc.).
Options Configuration of an 

external tool
Set up an external tool (for example FrontPage).

Change 
workspace...

Changing a workspace directory.

Default display Restoring the three-dimensional view of the work window by default.

Automatic input Fill in automatically the values of a new variable by incrementing the values 
of the last record.

Help Help Access to Web Designer Help file.
About Information about the version, copyright etc. of Web Designer.

Menu Sub-menu Overview
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Contextual Menu

Table
The following table shows the contextual menu of the file tree.

File tree item Menu (right-click) Sub-menu Comment
Project name New Project

Target
Launch the wizard. 1st window.

Edit
Paste Paste project.
Delete Destroy project.
Rename Rename project.
Global transfer Transfer project.
Properties View the project properties.

Module name New Device
Service

Launch the wizard. 2nd window.

Edit
Cut Cut module.
Copy Copy module.
Paste Paste module.
Delete Delete module.
Rename Rename module.
Transfer PC->Target

Target->PC
Transfer web site.

Connect Target
Simulation

Connect module.

Disconnect Disconnect module.
Properties View the module's properties.

Devices folder New device View the selection window of symbols.
Paste Paste device.

Device element Edit Launch the device display window.
Cut Cut device.
Copy Copy device.
Delete Delete device.
Rename Rename device.
Run Start the service.
Stop Stop the service.
Partial transfer Target>PC Transfer only the folder.

GraphicScreens folder New Microsoft Blend 
Application

Launch Microsoft Expression Blend® 
software.

New Graphic Page Launch Graphic Editor.
Paste Paste the graphic.
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Import Blend 
Application

Open dialog for navigating to and selecting 
an existing Microsoft Expression Blend 
application. 

Soap Debug Mode Enable/Disable Enables/Disables the use of PLC data by the 
Microsoft Expression Blend application.

Partial transfer Target>PC
PC->Target

Transfer only the folder. 

GraphicScreens item Edit Graphic Editor.
Open View graphic.
Cut Cut the graphic.
Copy Copy the graphic.
Delete Delete graphic.
Rename Rename gaphic.
Partial transfer Target>PC

PC->Target
Transfer only the folder. 

DataTables folder New data Launch the data editor.
Paste Paste the data table.
Partial transfer Target>PC

PC->Target
Transfer only the folder. 

DataTables item Edit Data Editor.
Open Data Viewer.
Cut Cut the data table.
Copy Copy the data table.
Delete Delete the data table.
Rename Rename the data table.
Partial transfer Target>PC

PC->Target
Transfer only the folder. 

 Services folder New service Create a new service.
Paste Paste a service.
Partial transfer Target>PC 

PC->Target
Transfer only the folder. 

A Services folder
calculation, email, 
database, data 
logging, active pages

New Launch the service wizard with the selected 
service.

Cut Cut a service.
Copy Copy a service.
Paste Paste a service.
Delete Delete a service.
Partial transfer Target>PC 

PC->Target
Transfer only the folder. 

Services item Edit Launch the edit window of the service.
Cut Cut the service.

File tree item Menu (right-click) Sub-menu Comment
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Copy Copy the service.
Delete Delete the service.
Rename Rename the service.
Run Start the service.
Stop Stop the service.
Partial transfer PC->Target Transfer only the folder. 

Website folder New Folder
File

Create a new file or folder.

Paste Paste a new file or folder.
Import File Importing an existing website.
Partial transfer Target>PC

PC->Target
Transfer only the website. 

Folder in Website New Folder
File

Create a new file or folder.

Cut Cut the folder.
Copy Copy the folder.
Paste Paste a new file or folder.
Delete Delete the folder.
Rename Rename the folder.
Import File Importing an existing file.
Partial transfer Target>PC

PC->Target
Transfer only the folder. 

File in WebSite Open Open the file.
Open with System 
Editor

Launch another window with System Editor.

Edit with Notepad Launch the HTML page in Edit mode with 
notepad.

FrontPage Launch the HTML page in Edit mode with 
FrontPage.

Cut Cut the file.
Copy Copy the file.
Delete Delete the file.
Rename Rename the file.
Partial transfer Target>PC

PC->Target
Transfer only the file.

Namespace Open Launch the Namespace window.
Namespace Write 
Access

Edit Launch the author rights Namespace 
window.

File tree item Menu (right-click) Sub-menu Comment
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A
applet

Software component that runs in the context of another program, for example a Web browser.

ASCII
American Standard Code for Information Interchange.
Pronounced "aski". This is an American code (but now an international standard) which allows 
alphanumerical characters used in English, punctuation marks, some graphics characters and 
various commands to be defined with 7 bits.

AT commands
Also called Hayes Commands: Set of commands for various phone-line manipulations, dialing and 
hanging up for instance.

B
bit

Contraction of Binary Digit.
This is the binary unit of information content, which can represent two separate values (or states): 
0 or 1.
A field of 8 bits constitutes 1 byte.

BOOTP
Bootstrap Protocol: Protocol for booting diskless terminals or stations by centralized management 
of network parameters.

C
CF card

CompactFlash card: Type of data storage device, used in portable electronic devices.

communication interruption
Communication error detected by the module when the periodic exchanges with the PLC stop.

configuration
The configuration comprises the data that defines the device (invariable) and that is necessary to 
the operation of the module.
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CPU
Central Processing Unit: The microprocessor. This comprises the entire control unit and the 
arithmetic unit. The purpose of the control unit is to extract the execution instruction from the 
central memory along with the data needed to execute this instruction, to establish electrical 
connections in the arithmetic and logic unit and to start the processing of this data in the unit. ROM 
or RAM memories are sometimes included on the same chip, and sometimes I/O interfaces or 
buffers.

CRC
Cyclic Redundancy Check: Type of hash function used to produce a checksum – a small, fixed 
number of bits – against a block of data, such as a packet of network traffic or a block of a computer 
file.

D
DHCP

Dynamic Host Configuration Protocol: Protocol allowing a station connected to the network to 
obtain its configuration dynamically.

DNS
Domain Name System: It stores and associates many types of information with domain names and 
it translates domain names (computer hostnames) to IP addresses.

driver
Program which informs the operating system of the presence and characteristics of a peripheral.

E
Ethernet

Ethernet is a LAN cabling and signaling specification used to connect devices within a defined area 
(such as a building). Ethernet uses a topology such as bus or star to connect different nodes on a 
network.

F
FactoryCast HMI

Active Web server that executes HMI functions integrated in a PLC module. When you use the 
active Web server, you do not need to communicate via polling to update the HMI/SCADA 
database.

FDR
Faulty Device Replacement: Automatic configuration recovery service provided by the module. 

firewall
Information technology (IT) security device which is configured to permit, deny or proxy data 
connections set and configured by the organization's security policy.
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Flash memory
Form of non-volatile computer memory that can be electrically erased and reprogrammed. 

FTP/TFTP
File Transfer Protocol/Trivial File Transfer Protocol: Network file transfer protocol.

G
GPRS

General Packet Radio Service: A radio technology for GSM networks that adds packet-switching 
protocols and shorter set-up time for ISP connections.

H
HMI

Human Machine Interface: The aggregate of means by which people (the users) interact with a 
particular machine, device, computer program or other complex tool (the system).

HTML
HyperText Markup Language: the predominant markup language for the creation of web pages. It 
provides a means to describe the structure of text-based information in a document and to 
supplement that text with interactive forms, embedded images, and other objects.

HTTP
HyperText Transfer Protocol: Network transfer protocol for documents written in hypertext (links).

I
IP

Internet Protocol: Data-oriented protocol used for communicating data across a packet-switched 
internetwork (i.e. the Internet).

IP Address
Unique address that devices use in order to identify and communicate with each other on a 
computer network utilizing the Internet Protocol standard (IP)—in simpler terms, a computer 
address.

ISO
International Standards Organization. Formats, symbols, transmission rules are covered by ISO 
standards. AFNOR is a member of ISO.

ISP
Internet Service Provider: Business or organization that sells to consumers access to the Internet 
and related services.
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M
MIB

Management Information Base: Database used by the SNMP protocol for network management 
and containing information on data transmission, station or router components, etc.

MIB II: standard MIB
Schneider Electric MIB: private MIB

N
NAT

Network Address Translation: is the translation of an Internet Protocol address (IP address) used 
within one network to a different IP address known within another network.

NTP
Network Time Protocol: Protocol for synchronizing the clocks of computer systems over packet-
switched, variable-latency data networks.

O
operating mode

The rules governing the behavior of the module when it is running.

P
PAP

Password Authentication Protocol: Password identification protocol used for remote modem 
connections.

PL7
Schneider Electric PLC programming software.

PLC
Programmable Logic Controller: It is a small computer used for automation of industrial processes, 
such as control of machinery on factory assembly lines.

PPP
Point-to-Point Protocol: Point-to-point communication protocol used for modem connections.

Premium
Family of Schneider Electric PLCs.

PSTN/RTC
Public Switched Telephone Network: The network of the world's public circuit-switched telephone 
networks.
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Q
Quantum

Family of Schneider Electric PLCs.

R
RGB

Additive model in which red, green, and blue (often used in additive light models) are combined in 
various ways to reproduce other colors.

RS232
Serial communication standard that in particular defines the following operating voltage:

A signal of +3 to +25V indicates logical value 0.
A signal of -3V to -25V indicates logical value 1.

Between +3V and -3V the signal is regarded as invalid.
RS 232 connections are relatively sensitive to interference. The standard recommends not 
exceeding a distance of 15 meters and a speed of 20,000 baud (bps) maximum.

RS485
Serial connection standard operates at +/-5V differential. The connection uses separate wires for 
transmission and receipt. Their "3-status" outputs allow them to switch to listening mode when 
transmission is completed.

RTU
Remote Terminal Unit.

RUN
Function used to start execution of the application program in the PLC.

S
SCADA

Supervisory Control And Data Acquisition: Software that, interfacing with a programmable logic 
controller, gathers and analyzes information used to monitor and control commercial equipment.

SMTP
Simple Mail Transfer Protocol: Application protocol used to transmit messages via the Internet and 
direct them to a mailbox.

SNMP
Simple Network Management Protocol: Network management protocol for controlling a network 
remotely by polling the stations for their status and modifying their configuration, performing 
security tests and viewing information relating to data transmission. It can also be used to manage 
software and databases remotely.
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SQL
Structured Query Language: Used to query (request data from) a relational database.

T
TCP

Transmission Control Protocol: Virtual circuit protocol that is one of the core protocols of the 
Internet protocol suite, often simply referred to as TCP/IP.

TCP/IP
The set of communications protocols that implement the protocol stack on which the Internet and 
many commercial networks run.

Time Out
Expiry of a waiting time. Stops the application or disconnects after a lengthy period of non-use.

U
UDP

User Datagram Protocol: One of the core protocols of the Internet protocol suite. Using UDP, 
programs on networked computers can send short messages sometimes known as datagrams to 
one another.

URL
Uniform Resource Locator: The global address of documents and other resources on the World 
Wide Web.

V
VPN

Virtual Private Network: A private network that is configured within a public network. It uses 
encryption and other security mechanisms so that only authorized users can access the network 
and that the data cannot be intercepted.

X
XML

Extensible Markup Language: it is aimed to facilitate the sharing of data across different 
information system. It is a simplified subset of the SGML and is designed to be relatively human-
legible.
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A
automatic input, 68

D
Data Editor

spreadsheet, 74
symbol, 77
templates, 76
variable, 74, 77

data templates, 76
direct addresses, 79

E
example

see (getting started), 17
export, 42
external tool

configuration, 129

F
format target, 135

G
getting started, 17

accessing the website, 32
configuring the module, 22
creating a new project, 19
Data Editor, 26
Graphic Editor, 28
presentation, 18
selecting devices, 20
selecting variables, 24
transferring a project, 30
35016149 10/2017
Graphic Editor
applet parameters, 92
presentation, 82
properties sheet, 90
security, 91
toolbar, 84
user functions, 88

Graphic objects
extended, 110
presentation, 93

I
import, 42

synchronization, 67
importing a FactoryCast project and web site, 
43
installation, 12
introduction, 10
IP address, 48

M
module

connecting/disconnecting, 55
FTP, 50
IP address, 48

N
namespace, 64

write access, 69

O
online documentation, 50
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P
password, 142

configuration, 144
HTTP, 144
write, 144

PC configuration, 11
PLC program viewer, 121
presentation, 10
project

add devices, 38
add targets, 37
close, 41
device list, 39
global transfer, 50
open, 41
partial transfer, 50
remove items, 40
remove targets, 37, 39
save, 41
target list, 36
transfer, 49
validation, 51

R
reboot target, 135

S
security

access, 141
Security

access, 138
firewall, 139
passwords, 138

Silverlight pages, 120
simulation, 58, 59
site explorer, 50
symbol

 name, 64
import from PLC, 65
manual selection, 68

synchronization, 67
160
T
transfer status, 52

V
variable

import from PLC, 65
manual selection, 68
name, 64
Unity Pro, 67

W
Web Designer

close, 41
Workspace directory, 133
write

password, 144
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